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Flowchart 1: Risk-informed Hydrologic Evaluation and Consequence Analysis for Existing Dams 

 

Reference Overview of Hydrologic Evaluation and Design Process, State of Colorado Dam Safety, March 2021.  



Flowchart 2: Inflow Design Flood (IDF) Study for Design of New Dams and Modifications to Existing Dams 
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Hydrology study reporting requirements are provided throughout Sections 5 through 10 
below and are marked with a scroll icon and section heading in red text.  Reporting will 
facilitate subsequent steps in the hydrology modeling & checking process.  Please see 
Example reports in Appendix A and Reporting checklists in Appendix C before you 
begin. 

 
YouTube tutorial videos demonstrating application of these guidelines, with examples, are provided 
on the Colorado DWR YouTube channel: 
https://www.youtube.com/playlist?list=PLfxQZOzykdUvqEWL3c4HtbAV2LeKCY9Tm 

https://drive.google.com/drive/folders/1BSZiRgODwXxi_AvlPn5hwgQrcYaJunl0?usp=sharing
https://drive.google.com/drive/folders/1EfH1hkcY41VxTZk0QFJfIPcadkQ-61Sm?usp=sharing
https://www.youtube.com/playlist?list=PLfxQZOzykdUvqEWL3c4HtbAV2LeKCY9Tm
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Section 1. Introduction 

This document provides Colorado Dam Safety guidelines for hydrological modeling and flood 
analysis for design and risk analysis of hydrologic features of dams.  Guidelines represent the 
agency’s current thinking and are recommended for use on projects that require agency 
approval.  We have spent many years updating our approach to hydrological analysis.  From about 
2016-2018, Colorado and New Mexico performed a multi-year Regional Extreme Precipitation 
Study (REPS), which developed new probable maximum precipitation (PMP) estimates and 
extreme precipitation frequency estimates for the region.  The REPS study was overseen by a 
project review board of federal and state subject matter experts.  Using probabilistic rainfall 
estimates from REPS, Colorado developed a new hydrologic risk analysis framework, in which 
hydrologic event likelihood and consequences of hydrologic dam failure are used for risk-
informed evaluation of existing dams and to develop risk-based Inflow Design Flood (IDF) criteria 
for dam design.  During 2018 – 2021, Colorado Dam Safety collaborated with Colorado State 
University (CSU) to develop improved hydrological rainfall-runoff modeling methods to more 
accurately represent extreme flooding in Colorado, particularly in the mountains and Colorado’s 
western slope, where historically dam safety modeling methods have grossly over-estimated the 
magnitude of floods, relative to the observed flood record.  Finally, Colorado Dam Safety 
recognized the need to incorporate information about observed floods, both site-specific and 
regional, into dam safety flood analysis.  Significant efforts to document and understand 
extreme/extraordinary floods and paleo-floods in Colorado have been made over the past 30 
years by U.S Geological Survey (USGS) researchers Robert Jarrett and Michael Kohn, U.S. Army 
Corps of Engineers hydrologist John England, and others.  Valuable regional data sets like USGS 
StreamStats and the USGS Colorado Flood Database can help estimate floods for dams on ungaged 
basins.   

These guidelines describe a new and different hydrological modeling process that incorporates 
site-specific and regional observed flood information.  We still greatly rely on rainfall estimates 
and rainfall-runoff modeling to simulate flood timing, durations, volumes, and to extrapolate to 
unobserved floods.  Yet while REPS rainfall estimates and the CSU rainfall-runoff modeling are 
considered to be best available science, they involve many simplifying assumptions, e.g., 
assumed storm transpositions limits, idealized temporal distributions, use of large-scale soil 
surveys to estimate soil hydraulic properties, etc.  Uncalibrated rainfall-runoff model results are 
viewed here as an initial starting point, and reasonableness or accuracy of such results should not 
be assumed.  Checking and calibrating model results against the historical flood record is 
considered to be an integral step, involving stream gage flood frequency analysis, regional flood 
frequency relationships, historical flooding, history and frequency of spillway activation, record 
pools, regional peak flow envelopes, and more, all to make a case for model results.  Only after 
these checks are done do we consider the model to provide a best-estimate of flooding.  At the 
same time, confidence is built through the reasonableness checks process. Some dams and basins 
may have a large amount of historical flood information, which makes a case for strong 
confidence in model results.  Other basins may have very little flood information and may rely on 
regional data sets.  Regardless, we have found that the process yields more defensible hydrology 
results than odeling alone.      

Caveats:  
1. Before starting a new hydrology study, please see our Overview of Hydrologic Evaluation and 

Design Processes document for a high-level roadmap of our two distinct hydrology processes: 
(1) risk-informed hydrologic evaluation for existing dams and (2) inflow design flood (IDF) 
analysis for new dams/modifications.  Hydrologic risk analysis involves probabilistic analysis 
and consequence analysis of hydrologic dam failure, and is the basis for Colorado Dam 
Safety’s risk-informed hydrologic evaluation of existing dams (see Flowchart 1, inside front 
cover herein).  In contrast, IDF studies are used to develop a design flood to be used in 
design of new or modified dams and appurtenances (see Flowchart 2).    

https://drive.google.com/file/d/1cSFNwR4QXiBUatmlSXVGTG59KVdkpZk-/view?usp=sharing
https://drive.google.com/file/d/1cSFNwR4QXiBUatmlSXVGTG59KVdkpZk-/view?usp=sharing
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2. Please also see the following related Colorado Dam Safety guidelines:  
• For extreme rainfall estimation using Colorado’s Regional Extreme Precipitation Study 

(REPS) tools, please see Guidelines for the Use of Regional Extreme Precipitation Study 
(REPS) Rainfall Estimation Tools  

• For analysis and estimation of consequences from hydrologic dam failure (used for 
hydrologic risk analysis and to determine risk-based Inflow Design Flood criteria), please 
see Guidelines for Hydrologic Hazard Analysis. 

3. Previous Colorado Dam Safety Hydrologic Basin Response and Parameter Estimation 
Guidelines (2008) are superseded by these current hydrological modeling guidelines.   

Section 2. Background 

Previous Colorado Dam Safety hydrology guidelines (2008) recommended the Green & Ampt 
method to model infiltration losses.  Because Green & Ampt is an infinite sink (i.e., losses are 
unlimited), maximum infiltration rates (Ksat) were artificially capped at 1.2 in/hr to prevent 
overestimation of losses.  In practice, we found this approach could both underestimate losses 
for high-intensity thunderstorms (because the infiltration rate was artificially capped) and 
overestimate losses for low intensity general storms (because Green & Ampt is an infinite sink).  
This is particularly true for forested, mountain basins that have coarse grained, thin soil profiles.  
Our previous guidelines also recommended using U.S. Bureau of Reclamation Flood Hydrology 
Manual (Cudworth, 1989) unit hydrographs.  The Rocky Mountain Thunderstorm UH in particular 
produced flashy design flood hydrographs, with implausibly high peak flows for Colorado’s high-
mountain basins.  

Flood Hydrology Manual (Cudworth, 1989) hydrology methods have been popular for dam safety 
purposes for many years.  But at the time of its publication Cudworth acknowledged “data 
representing basins located at higher elevations of these [Rocky Mountains] mountain ranges are 
generally lacking”, and “the infrequency of severe rainstorms in these areas…precludes 
acquisition of a good data base representing severe event phenomena”.   Like our previous 
guidelines, Cudworth also recommended artificially low infiltration rates for modeling in order to 
explain observed floods. Then, unique to his treatment of the western U.S., he concluded there 
were two distinct rainfall-runoff UH transformations for the Rocky Mountain region: a slow 
transformation response for low‐intensity general storms and a fast transformation for 
high‐intensity thunderstorms.  The new method presented herein is better at reproducing 
observed floods in the Rocky Mountains.  

In 2017, as part of a site-specific hydrology study for a dam enlargement project, Colorado Dam 
Safety developed a proof-of-concept hydrology model (“Mountain Hydrology Model”) that used 
higher infiltration rates (i.e., without artificial caps) and an approximate method of soil moisture 
accounting.  At the same time, the project’s design engineers used a traditional flood hydrology 
model using lower infiltration rates from Cudworth (1989).  In general, the Colorado Dam Safety 
method outperformed the traditional model in reconstructing September 2013 flood hydrographs 
on a Front Range drainage, extending from high mountains down to the lower foothills (Perry et 
al, 2017).  Figures 1 and 2 below compare simulated hydrographs at Pinecliffe (Figure 1), a high 
mountain location where infiltration losses were high and little surface runoff was observed, and 
at Eldorado Springs (Figure 2), along the first upslopes, where runoff was large but could only be 
explained by delayed saturation-excess runoff.  Table 1 compares simulated September 2013 
flood peak discharges and Probable Maximum Flood peaks calculated by the Mountain Hydrology 
Model and the traditional flood hydrology model for the study basin, and shows regional flood 
frequency and paleoflood peak flow estimates for comparison.      

https://dnrweblink.state.co.us/dwr/ElectronicFile.aspx?docid=3566813&dbid=0
https://dnrweblink.state.co.us/dwr/ElectronicFile.aspx?docid=3566813&dbid=0
https://dnrweblink.state.co.us/dwr/ElectronicFile.aspx?docid=3566810&dbid=0
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Figure 1:  Colorado Dam Safety Mountain Hydrology model Sept 2013 hydrograph on South Boulder Creek at Pinecliffe (near 

7930 ft elevation) versus the observed flood and a traditional flood hydrology model simulation.  High infiltration losses 
occurred in the mountains above Pinecliffe and the traditional model significantly overestimated runoff (Perry et al, 2017). 

 

 
Figure 2:  Colorado Dam Safety Mountain Hydrology model Sept 2013 hydrograph on South Boulder Creek at El Dorado Springs 
(near 6080 ft elevation) versus the observed flood and a traditional flood hydrology model simulation.  Large runoff occurred 

here, but could only be explained by saturation-excess runoff and associated delayed runoff peak, which the traditional 
infiltration-excess model could not do (Perry et al, 2017). 
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Table 1:  Comparison of peak flows and runoff volumes from Colorado Dam Safety’s Mountain Hydrology Model versus 
traditional dam safety flood hydrology model for a Front Range basin.  Regional flood frequency and paleoflood peak flow 
estimates are provided for comparison (Perry et al, 2017).  
 Observed Colorado Dam Safety 

Mountain Hydrology Model 
Traditional Dam Safety Flood 

Hydrology Model 
Peak Q at Pinecliffe, cfs (% 
error) 

780 731 (-6%) 3415 (+338%) 

Runoff Volume at Pinecliffe, 
ac-ft (% error) 

4429 4425 (0%) 4195 (-5%) 

Peak Q at Eldorado Springs, 
cfs (% error) 

2552 2436 (-5%) 5768 (+126%) 

Runoff Volume at Eldorado 
Springs, ac-ft (% error) 

5221 5705 (+9%) 7442 (+30%) 

Probable Maximum Flood 
Peak Q (cfs) at Gross Dam 
[upstream of Eldorado 
Springs] (DA=93 sqmi) 

n/a 16,026 cfs(1) 40,115 cfs(1) 

Regional Flood Frequency and Paleoflood Estimates For Comparison 
Bulletin 17C 500-YR (0.2%) 
Peak Flow Estimate at 
Eldorado Springs (DA=111 
sqmi) 

4,970 cfs 

Paleoflood Q Olympus Dam, 
Estes Park, CO (DA=138 
sqmi) 

3000-5000 cfs (P=3,000-5000 years), (Jarrett, 1989) 

Paleoflood Q at Buttonrock 
Dam (DA=101 sqmi) 

7,300-9,950 cfs (P=6,500-6,700 years), (USBR, 2015) 

Note (1) PMF here was calculated using Site Specific PMP, estimated in a similar manner as the CO-NM REPS study.  The 
historical PMF using HMR 55A rainfall had a peak discharge of around 90,000 cfs. 

Following the 2017 proof-of-concept study, Colorado Dam Safety began a multi-year Mountain 
Hydrology Research Study with Colorado State University to develop new hydrology methods that 
accurately reproduce extreme flood production mechanisms in Colorado.  In Phase I, CSU 
researchers used the soil moisture accounting (SMA) loss method in HEC-HMS to simulate 
historical extreme floods from 1976, 1997 and 2013 in five Colorado Front Range basins.  They 
showed that HEC-HMS with SMA can produce three runoff mechanisms: infiltration excess runoff, 
saturation excess runoff (assumed to occur where saturation fraction of soil storage exceeds 
85%), and subsurface lateral flow.  Further they showed that these mechanisms are necessary 
and sufficient to accurately simulate observed flood hydrographs (Woolridge, 2019 and Woolridge 
et al, 2020).   

During the course of the CSU Phase I study, Colorado Dam Safety completed the Regional 
Extreme Precipitation Study (REPS), which provides updated extreme precipitation frequency and 
probable maximum precipitation estimates for Colorado.  REPS found that there are three 
distinct storm types that produce extreme precipitation here: local convective storms (small 
scale, short-duration, extreme rainfall intensity), meso-scale with embedded convection storms 
(medium spatial scale and duration, with embedded high rainfall intensity), and mid-latitude 
cyclones (large spatial coverage, long duration, and low rainfall intensity).  In the Mountain 
Hydrology Study, CSU modeled REPS design storms by storm type for the five Front Range study-
basins and showed that the controlling runoff mechanisms vary by storm type, storm magnitude, 
and by drainage basin (see Table 2).  Traditional dam safety hydrology assumes that only 
infiltration excess runoff is relevant to extreme floods for dam safety design, but the CSU study 
showed that soil saturation runoff and subsurface flow can be relevant as well.  Therefore, a 
hydrological model that produces these three runoff mechanisms is necessary.   
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In Phase II of the Mountain Hydrology Research Study, CSU developed parameter estimation 
methods for HEC-HMS SMA and then verified these methods for three basins and six historical 
floods in the San Juan Mountains (Irvin et al, 2021).   CSU’s research forms the basis of the CSU-
SMA modeling method presented herein.   

Finally, a large amount of historical extreme and extraordinary flood information exists for 
Colorado and forms the basis of reasonableness checks and model calibration discussed later in 
Sections 9 and 10 of these guidelines.  In brief, two simple figures will suffice here to show key 
regional characteristics of historical floods in Colorado: Figure 3, taken from Jarrett and 
Tomlinson (2000), shows two curves of maximum observed unit discharges versus elevation.  The 
following conclusions can be made: (1) flood yields are typically much higher in Eastern Colorado 
(east of the Continental Divide) than on the Western Slope below about 2,300 meters 
(approximately 7,500 feet) elevation and (2) flooding decreases dramatically with increasing 
elevation along the Front Range, with relatively low unit discharges observed above about 7,500 
feet elevation.  And Figure 4, taken from Smith et al (2018), shows that some of the country’s 
most extreme floods (red dots), in terms of the ratio of observed peak flows to 10-YR flood 
frequency estimates, can occur in Colorado, but are concentrated along the highly-dynamic 
weather region of the Front Range foothills.     
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Figure 3:  Regional relationships between maximum observed flood yields and elevation in Eastern Colorado and Northwest 

Colorado (from Jarrett and Tomlinson, 2000) 
 

 
Figure 4:  USGS stream gage locations where the ratio of maximum observed flood peak to the 10-YR flood frequency estimate 

is greater than 20 (red dots), 10-20 (green) and 5-10 (blue) (from Smith et al, 2018) 
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Section 3. Overview of CSU-SMA Hydrology Modeling Method  

3.1 The previous section explained limitations of traditional dam safety flood hydrology 
modeling approaches and introduced the new Colorado State University-Soil Moisture Accounting 
(CSU-SMA) approach that can simulate infiltration-excess, saturation-excess, and subsurface 
runoff.  Equally important is the use of the Clark Unit Hydrograph method, which allows more 
flexibility in modeling runoff transformation to shallow subsurface flow versus quickflow.  
Woodridge et al (2020) showed these flood production mechanisms are necessary and sufficient 
to reproduce historical extreme flood hydrographs in Colorado’s Front Range Mountains and that 
they are necessary to capture variations in controlling design floods by REPS storm type for dam 
safety purposes.  

3.2 This section provides an overview of the CSU-SMA model. It was developed using HEC-HMS 
4.7; however, because computer programs change frequently, the discussion here is intended to 
allow adaptation to future versions of HEC-HMS or other hydrology modeling software.  Figure 5 
provides a schematic of the elements in the CSU-SMA method.  Precipitation is the first element 
and is input using REPS design storm temporal patterns.  Canopy storage represents interception 
that must be filled before throughfall occurs to the ground surface.  In the CSU-SMA model water 
can leave canopy storage through evaporation.  Throughfall will infiltrate the soil profile at a 
rate up to the soil infiltration capacity, after which infiltration-excess runoff occurs (surface 
runoff).  Infiltration capacity is defined by a linearly-decreasing function of soil [water] storage 
in the profile (Figure 6).  Infiltration losses are tracked and go towards filling the specified soil 
[water] storage volume.     

 
Figure 5: Schematic of CSU-SMA method (Woolridge, 2019) 

 

 
Figure 6: HEC-HMS SMA relationship between infiltration Capacity rate and Soil [water] Storage (Woolridge, 2019). 
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As soil water storage increases towards saturation, infiltration capacity decreases from its 
maximum, at zero soil storage, to zero infiltration, at soil saturation.  This is a key difference 
from previous Green & Ampt and Initial and Constant Loss methods, which allowed infiltration to 
continue indefinitely.  In the CSU-SMA model, as soil storage fills and infiltration approaches 
zero, then throughfall is forced to run off as saturation-excess runoff.  At the same time, as the 
soil storage fills, soil water is allowed to percolate to a lower groundwater layer, which then can 
flow laterally back to streamflow or can percolate out of the system.   

3.3 Other models, both existing and future, may be able to adequately represent the necessary 
flood production mechanisms.  These may include GSSHA, MIKE SHE, SEFM and others.   A layered 
Green & Ampt approach with soil moisture accounting may accurately model both infiltration-
excess and saturation-excess runoff.  Engineers may use adequate modeling methods other than 
the one described below, however, the reasonableness checks and calibration procedures 
described later in this document should be performed.  NOTE: the SCS Curve Number method 
models a conceptually similar finite infiltration capacity (S); however, CN, from which S is 
calculated, is not physically based, and the SCS CN method does not produce subsurface flow.   

3.4 The CSU-SMA model uses the Clark UH method in HEC-HMS for rainfall-runoff 
transformation.  The Clark UH is well documented in hydrology literature and is widely used in 
practice.  Our experience (and CSU research) suggests that the unit hydrograph approach is 
adequate for modeling floods in most undeveloped basins in Colorado, especially when model 
results are considered along with the reasonableness checks and calibration described in these 
guidelines.  That said, other transform methods, including distributed models like HEC-RAS, may 
be justified on a basin-specific basis, for example, where basin shape, terrain or development do 
not lend themselves to a simple unit hydrograph approach. 

3.5 The CSU-SMA model uses the Linear Reservoir baseflow method.     

3.6 The CSU-SMA loss method in combination with the Clark UH is a conceptual approach that 
can produce a wide range of streamflow responses seen in the diverse terrain across Colorado.  
Later in these guidelines we suggest that flashy unit hydrograph surface runoff response is typical 
of floods in the Front Range foothills, Eastern Plains, and western canyons, indicating quickflow 
or Horton runoff; whereas, slower unit hydrograph response is typical of mountain basins, 
indicating interflow or shallow-subsurface flow.  Mountain watersheds often have coarse-grained 
soils, fractured surficial bedrock, and large colluvial deposits, which may act to minimize 
quickflow and increase interflow and groundwater flow.  Conceptually the CSU-SMA model 
represents both quickflow and interflow as “surface runoff”, but Clark UH parameters can be 
varied to differentiate between them.  Using checks and calibration against the observed flood 
record (Sections 9 & 10 herein), the CSU-SMA model can reproduce these varied conditions.  

3.7 Snowmelt and rain-on-snow runoff are not explicitly addressed in the CSU-SMA modeling 
method.  Clearly snowmelt is an important runoff production mechanism for mountain basins in 
Colorado.  Typically, annual peak flows for basins above about 7,500 feet elevation are caused by 
snowmelt. However, Colorado Dam Safety’s experience is that snowmelt floods do not control 
flooding at rare probabilities of interest for design of High and Significant Hazard dams. (For Low 
Hazard dams, flood frequency analysis or regional peak flow relationships, e.g. USGS 
StreamStats, both of which would reflect the influence of snowmelt runoff, should be used to 
determine more frequent inflow design floods -- see inset on Flowchart 2 above).  Likewise rain-
on-snow flooding has the potential to cause large floods, but seems to be rare in Colorado at this 
time, subject to future climate change.  Rain-on-snow modeling is not specifically addressed in 
the CSU-SMA modeling method, but it can be identified by checks against the observed flood 
record described herein.  Rain-on-snow modeling may be warranted on a basin-specific basis, 
where the observed flood record indicates it is relevant to extreme flood production.  
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Figure  7: Overview of data  sources, processing, and model parameters for the CSU-SMA modeling method (from Irvin et al, 2021, with permission).
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Figure 7 gives an overview of the data, processing, and model parameters that are needed for 
the CSU-SMA modeling method.  The following Sections 4, 5, and 6 provide details on each step.  

3.8 Limitations:  The CSU-SMA modeling method described below requires user expertise 
and judgment.  Sections 4-8 provide prescriptive steps, which should be considered as a 
starting point. Sections 9 and 10 describe checks, confidence, and calibration, which require 
hydrology and engineering expertise to ensure that model results are reasonable.  Ultimately 
it is up to the engineer/user to make the case for their hydrology analysis and results; 
multiple lines of evidence (e.g. rainfall-runoff modeling, flood frequency analysis, review of 
historical floods) will increase confidence.      

Key references used in these guidelines are available at the following DWR ftp link for easy 
access and transparency so that the user is fully informed of the methods described herein (also 
see References section at the end of these guidelines):  

https://drive.google.com/drive/folders/1bJBtYHy96ejo1YdS5xosaJi2TsVKto20?usp=sharing 

The CSU-SMA method has been tested over a variety of basins across Colorado; however, 
situations requiring engineering judgment are sure to arise, at the responsibility of the user.  
Likewise, the computer tools provided herein are provided in good faith to advance the safety of 
dams in Colorado, and should be used at the user’s risk.  The methods and tools were developed 
using HEC-HMS 4.7 and ArcMap 10.4.1 with Spatial Analyst Extension.  Colorado Dam Safety will 
attempt to update these guidelines following major software changes; however, some amount of 
interpretation for software changes and data sources should be expected by the user. 

Lastly, these guidelines do not address burn scar hydrology associated with wildfires or their 
increasing occurrence in Colorado.  Further research is needed on the effects of burn scar 
hydrology on extreme floods in Colorado and on joint probabilities associated with wildfire 
occurrence, burn scar duration, and extreme precipitation events in order to facilitate hydrologic 
risk analysis.  We hope to address these issues in the future.  Until then, risks associated with 
burn scar flooding should be addressed on an as-needed basis in consultation with Colorado Dam 
Safety.  

https://drive.google.com/drive/folders/1bJBtYHy96ejo1YdS5xosaJi2TsVKto20?usp=sharing
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Section 4. CSU-SMA Method Input Data 

4.1 This section describes input data sets needed for the CSU-SMA method using HEC-HMS 4.7 
and ArcMap 10.4.1 with Spatial Analyst Extension.  Data sources may change and are the 
responsibility of the user.  Tip: the CSU-SMA method involves a large amount of input and output 
data. We recommend creating a folder structure that roughly follows the organization of these 
guidelines (e.g. Input data->DEM, Landsat, REPS).   We recommend that all data be saved to the 
user’s hard drive/local drive to facilitate analysis is ArcMap.  

4.2 Drainage basin boundary and point of concentration GIS shapefiles:  These can easily be 
generated for the basin-of-interest using USGS StreamStats at https://streamstats.usgs.gov/ss/ 

4.3 DEM Terrain data:  DEM data is needed for input to HEC-HMS for delineation of sub-basins 
and for determining certain basin properties used for unit hydrograph transformation and reach 
routing.   DEM data can be downloaded from the USGS, currently at the following website: 
https://apps.nationalmap.gov/downloader/#/ 

In general, 10 meter (1/3 arc second) DEM grid resolution is considered to be adequate for 
hydrologic analysis; however, higher resolution DEM data, where available, may be useful for 
small or complex basins*.  DEM data must be in GeoTiff format. The following instructions are 
suggested for the current version of the USGS National Map website:  (1) zoom to area of interest 
on the map, (2) Select the following: Data sets tab -> Area of Interest=Map Extent; Data -> 
Elevation Products (3DEP) -> 1/3 are-second DEM -> File Format: GeoTiff, (3) Search Products 
(button at upper left), (4) Product tab -> add to cart, and (5) Cart tab -> download TIF.  Note 
that multiple DEM tiles may be needed to cover the basin-of-interest. 

* LiDAR DEM data for most of Colorado is available from the CWCB Colorado Hazard Mapping & Risk MAP 
Portal at the following weblink:  https://coloradohazardmapping.com/lidarDownload 

4.4 Landsat red and infrared band images1:  These data sets are needed to calculate fractional 
vegetative cover (Fg) for the basin.  Landsat images can be downloaded from the following 
website:  https://earthexplorer.usgs.gov/ 

The following instructions are suggested for the current version of the Earth Explorer website: (1) 
create a login (user must be logged-in to download data), (2) Set Search Criteria -> Use map and 
zoom to area of interest, (3) Select Data Sets -> Landsat-> Landsat Collection 2 -> Landsat 4-5 TM 
C2 Level-1 or Level-2, (4) Additional Criteria: Land Cloud Cover <10%, Satellite=Landsat5, (5) 
Select the “footprint” icon and choose a flight path(s) that covers the entire basin-of-interest, if 
possible (if multiple tif images are required, guidance on combining them for analysis is provided 
in Section 5 below).  The recommendation is to use imagery from September or October in order 
to conservatively estimate vegetative cover for the basin.  Another approach would be to base 
the Landsat imagery date/season on the seasonality of REPS design storms (discussed more in 
Section 9 below). Finally, (6) download the Landsat red (B3 band) and infrared (B4) GeoTiff 
file(s) using the download icon, then select the Product Options drop down from the Download 
Options window, and download the tif files ending in B3 and B4 (e.g., 
LT05_L1TP_034034_20111115_20200820_02_T1_B3.TIF .  

4.5 Soil property raster data sets:  Raster data sets of percent sand, percent clay, percent 
organic matter, and of depth to restrictive layer were obtained from the NRCS Gridded National 
Soil Survey Geographic Database (gNATSGO).  These raster data sets have been tiled and clipped 
to cover the tributary area of Colorado and can be downloaded from the following DWR ftp link. 

                                                 
1 NOTE: This Landsat-based method is provided as an automated, consistent way to estimate fractional vegetative 
cover (Fg), which is used in the CSU-SMA method to adjust infiltration rates.  Other methods to determine Fg, 
adequately justified, may be used, if desired. 

https://streamstats.usgs.gov/ss/
https://apps.nationalmap.gov/downloader/#/
https://coloradohazardmapping.com/lidarDownload
https://earthexplorer.usgs.gov/
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NOTE: (1) total file size is about 850 MB and (2) raster data units are % for soil texture rasters 
and centimeters for depth to restrictive layer:     
https://dnrftp.state.co.us/#/DWR/DamSafety/Colorado_Soils/ 

Alternatively, gNATSCGO data can be downloaded directly from the NRCS website: 
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625 

 
4.6 Design Storms, Temporal Data:  Colorado Regional Extreme Precipitation Study (REPS) PMP 
and precipitation frequency tools should be used for design storm inputs.  See Colorado Dam 
Safety’s Guidelines for the Use of Regional Extreme Precipitation Study (REPS) Rainfall 
Estimation Tools at the following Google Drive link: 
https://dnrweblink.state.co.us/dwr/ElectronicFile.aspx?docid=3566813&dbid=0 

Where a drainage basin size exceeds storm area size limits in REPS, then partial area analysis 
should be performed.  REPS area size limits by storm type are shown below in Table 3. 

Table 3:  REPS PMP Tool and MetPortal Precipitation Frequency tool storm area size limits by storm type 

 
 

Region 

REPS PMP, Storm Area Size Limits 

2-hr & 6-hr Local Storm PMP 24-hr Local Storm PMP 
72-hr General & Tropical 

Storms PMP 

All 100 sq mi 

Refer to area size of 
controlling historical 

storm(s), see REPS Summary 
Report Vol. II, App. F 

No limit 

 REPS MetPortal Precip. Frequency, Storm Area Size Limits 
 2-hr Local Storm PF 6-hr MEC Storm PF 48-hr MLC storm PF 

East Macro Region* 200 sq mi 500 sq mi 1000 sq mi 
Rio Grande Macro 

Region* 200 sq mi 500 sq mi 500 sq mi 

West Macro Region* 100 sq mi 200 sq mi 500 sq mi 
* REPS Metportal macro region for basin-of-interest is reported on the Watershed PF tab of MetPortal; also, the Macro 
Region layer can be turned on in the MetPortal map display. 

In general, partial area analysis should use the maximum storm area size allowed by REPS, with 
the storm area positioned closest to the dam or basin outlet.  Individual cases may vary in terms 
of determining controlling runoff.   

Tip: In practice, HEC-HMS modeling will be easier if sub-basins are delineated first (see 
Section 5 below), and then REPS partial areas, if needed, are selected to consist of discrete 
HEC-HMS sub-basins, as close in size to the REPS storm area size limits as possible without 
exceeding them.  Partial area shapefile(s) can be uploaded to REPS MetPortal and REPS PMP Tool 
(NOTE: For MetPortal make sure to first remove/dissolve any sub-basins boundaries in ArcMap).  
Finally, REPS partial area design storms can be input into HEC-HMS as precipitation gages and 
then assigned to the applicable sub-basins that comprise the partial area.  

Where the basin-of-interest is smaller than REPS storm area size limits, then simply run the REPS 
PMP and MetPortal precipitation frequency tools for the entire basin area.  We recommend using 
spatially uniform REPS design storms for most basins.  Optionally, the REPS PMP Tool will return 
partially distributed PMP estimates for sub-basin elements within a larger basin shapefile, if 
desired.  Our guidance is to use the sub-basins option when the REPS gridded PMP values vary 
significantly across the basin, for example, if the basin crosses major REPS climate regions like 
the 7,500-ft boundary along the Front Range foothills.         

https://dnrftp.state.co.us/#/DWR/DamSafety/Colorado_Soils/
https://www.nrcs.usda.gov/wps/portal/nrcs/detail/soils/survey/geo/?cid=nrcseprd1464625
https://dnrweblink.state.co.us/dwr/ElectronicFile.aspx?docid=3566813&dbid=0
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Section 5. Generating CSU-SMA Model Sub-basin Properties 

5.1 Some minor pre-processing of the input data is necessary in order to generate sub-basin 
properties in ArcMap and in HEC-HMS, which are in turn used to generate CSU-SMA model 
parameters.   

5.1.1 Calculate a fractional vegetative cover (Fg) raster from Landsat images 
(directions are based on ArcMap 10.4.1)2: 
• Load USGS Landsat 5 B3.tif (red) and B4.tif (near-infrared) images into ArcMap  
• If multiple Landsat tif images are needed to cover the basin-of-interest, then 

mosaic them in ArcMap: 
o use Data Management Tools -> Raster -> Raster Data set ->Mosaic 
o Input Rasters: select all B3 (or B4) tifs that cover entire basin 
o Target Raster: select one of the existing B3 (or B4) tifs 
o Mosaic operator: select Maximum 
o Ignore background value: 0 
o Mosaic Tolerance: 0 

• Calculate normalized difference vegetation index (NDVI) using ArcMap’s Map 
Algebra Raster Calculator in the Spatial Analyst Toolbox: Tip: Spatial Analyst 
license is required and the extension must be turned on. 

o In Raster Calculator, select output folder and name output raster NDVI 
o Enter the following NDVI equation in Raster Calculator:            

           
Float(B4 – B3)/Float(B4+B3)  

 
where B3 and B4 are Landsat 5 band rasters for red and NIR, respectively.   
Tip: Raster Calculator requires use of its functions, i.e., select functions, 
do not type them (e.g. “float” function is in the right hand menu box).  

o General notes about NDVI:  
 NDVI will range from 1 (if B3=0) to -1 (if B4 = 0) 
 Negative NDVI corresponds mostly to open water and snow; rock 

outcrop may also appear as negative 
• Next, calculate Fg from NDVI raster:   

o In Raster Calculator, select output folder and name output raster Fg 
o Enter the following Fg equation in Raster Calculator:   

 
(Float("NDVIi") – NDVI0)*(Float("NDVIi") – NDVI0) / ((NDVIinf – NDVI0)*(NDVIinf – NDVI0))  

 
where “NDVIi” is the NDVI raster calculated above, NDVIinf and NDVI0 are 
numerical estimates  for forested/lush vegetation and for bare soil 
locations, respectively.  Tip: The intent of NDVIinf and NDVI0 is to bracket 
the range of NDVI values for the basin-of-interest.    

o Montandon & Small (2007) suggest determining regional values for NDVIinf 
and NDVI0   Tip: turn on aerial photo in ArcMap and use Identify tool to 
find NDVIi raster values at heavily forested and at barren soil locations 
near the basin-of-interest.  ALTERNATIVELY, find min, max NDVI in ArcMap 
raster properties OR from the NDVI raster histogram (e.g. Spatial Analyst-
>Reclassify->Classify will generate a raster histogram)    

o Timilsina et al (2021) found NDVI0 =0.04, NDVIinf=0.7 for Colorado’s Front 
Range mountains.  Colorado Dam Safety has generally found similar values.     

                                                 
2 During beta testing, this Fg raster calculation resulted in some difficulty. Some testers asked if Colorado Dam 
Safety could calculate an Fg raster for the entire state?  Unfortunately, that is not practical because Landsat 
images should be selected based on low cloud cover, season-of-interest, etc. for each basin.  For perspective on 
your Fg effort, our recommendation is simply to use the Fg raster as a starting point, understanding that it affects 
SMA infiltration rate (see Section 6), which can be calibrated later by the procedures in Sections 9 & 10 below.   



 

 
Colorado Dam Safety Page 14 
Guidelines for Hydrological Modeling and Flood Analysis Rev.  September 12, 2022 

5.1.2 Next in terms of pre-processing input data to determine sub-basin 
properties: first mosaic DEMs if multiple DEMs are needed to cover basin-of-interest, 
(see ArcMap mosaic instructions in Section 5.1.1), then clip the DEM in ArcMap to the 
general basin area, in order to minimize drainage network processing time in HEC-HMS. 
We recommend clipping the DEM to the USGS StreamStats basin boundary shapefile with 
a buffer to allow for differences between USGS StreamStats and HEC-HMS DEM-based 
delineations: 
• To buffer basin shapefile:  Use ArcToolbox Analysis Tools->Proximity->Buffer 
• To clip the DEM tif:  

o Data management Tools -> Raster ->Raster Processing->Clip (keep output in 
tif format for use in HEC-HMS) 

o Check the box: Use input features for clipping geometry 
o Specify “.tif” extension in output raster filename 

5.2 For determining sub-basin properties, delineate sub-basins in HEC-HMS using the clipped 
DEM, then calculate sub-basin characteristics and reach characteristics in HEC-HMS3:  
• Open HEC-HMS, create a new project and save.   Select U.S. Customary units.  NOTE: DEM 

units (typically meters) are specified when the terrain model is imported (see below). 
• Create a basin model: Components >> Basin Model Manager 
• Create a terrain model: Components >> Terrain Model Manager 
• Name new Terrain 
• Navigate to your clipped DEM tif file (see above).  Specify elevation units (typically meters) 
• For Sub-basin Delineation:  In the watershed explorer, select the basin model and link 

Terrain Data to the new Terrain model, then follow the prompts: 
o Select UTM predefined coordinates (Zone 13N for most of CO, except Zone 12N for 

the far west) (GIS drop down menu, select coordinate system – predefined).  Tip: 
At this point user may need to link the basin model to the terrain model again for 
the DEM to appear in the HEC-HMS desktop display. 

o Next, GIS menu -> select “Process Sinks” – HMS will then identify and fill in any 
drainage pits in the DEM (NOTE: engineer should use judgement to determine 
whether this step is appropriate for the basin-of-interest) 

o GIS menu -> select “Process Drainage” – this step combines the creation of flow 
direction and flow accumulation grids.  

o GIS menu -> select “Identify Streams” – this will create a stream network based on 
a user-specified area threshold*  

 
*Guidance on Area Threshold:  Area threshold in HEC-HMS defines the minimum contributing area where 
streams start.  Area threshold is related to, but not equal to sub-basin area size. Under “Delineate 
Elements” (see below) HEC-HMS will create sub-basins at stream junctions -- smaller area thresholds will 
result in a denser stream network, which will result in more and smaller sub-basins (see Guidance on Sub-
basin Area Size below).  CSU’s Mountain Hydrology Research Study used an area threshold of 15 km2 (5.77 
sqmi) based on spatial variation in observed (historical) storm rainfall.  On one hand, for our purposes, 
REPS design storms do not have the same spatial variation (we generally use spatially uniform REPS 
rainfall); on the other hand, during Phase II verification, CSU found their model parameter estimation 
methods are dependent on area threshold size.  When larger areas were used (i.e. fewer sub-basins), CSU 
found that modeled peak flows were lower.  Therefore, we recommend using an area threshold of 10 sqmi 
or less. However, a mitigating factor here is our additional steps of reasonableness checks and model 
calibration against the observed flood record (Sections 9 & 10 below), which may provide an opportunity to 
“correct” a model that uses larger sub-basin areas. 

 
o Next, right click anywhere in the basin model window and select “Map Layers” -> 

Add -> USGS StreamStats point of concentration shapefile (i.e. 
globalwatershedpoint.shp) to define the basin outlet 

                                                 
3 The HEC-HMS method is described here for the user’s benefit. Other industry standard methods for sub-basin 
delineation and calculating basin properties are acceptable.  
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o Turn off all map layers except the USGS StreamStats POC and the Identified 
Streams layer 

o Zoom in to the POC  
o Use Break Point Creation Tool (cross with red dot) -> select point on stream closest 

to USGS StreamStats POC to define the basin outlet (Tip: break point must be 
directly on an identified stream) 

o Repeat Break Point Creation Tool to create break points at specific sub-basin 
locations*, if desired; otherwise, HEC-HMS will automatically delineate sub-
basins based on junctions in its identified stream network. 

 
*Guidance on Sub-basins (cross-reference Guidance on Area Threshold, above). 
The following factors should be considered in determining sub-basin area sizes and locations:  
1) REPS Climate Regions: Sub-basins should be used where REPS PMP estimates vary significantly across 

climate regions, for example, if the basin spans across REPS climate (storm transposition) zone 3 
(foothills) and zone 5 (mountains).  In this case, the sub-basins option should be used in the REPS PMP 
Tool to get semi-distributed sub-basin PMP estimates and then assign them as separate precipitation 
gages in HEC-HMS.   

2) REPS Storm Area Size Limits (see Section 4.6 above):  If the basin-of-interest exceeds REPS storm area 
size limits, then partial area sub-basins should be used for REPS analysis of relevant storm types. 

3) CSU Contributing Area Threshold (see Guidelines on Area Threshold above):  HEC-HMS area threshold 
per the above guidance will determine the density of HEC-HMS’s stream network and sub-basins at 
junctions, by default. However, if breakpoints are entered manually they will override the area 
threshold for sub-basin delineation. 

4) Physiographic differences:  Sub-basins should used to separate significant differences in basin soils, 
vegetative cover, slope, etc., which would result in different unit hydrograph responses and infiltration 
losses.      

5) Key locations for model reasonableness checks and model calibration: e.g. stream gage locations, 
locations of paleoflood estimates, indirect flood peaks, etc. 

 
o Next, use GIS menu and select “Delineate Elements”  
o Set subbasin prefix to “Sub-“, set reach prefix to “Reach-“, “Yes” for insert 

junctions, set junction prefix to “Junction-“, and “Yes” for convert breakpoints 
o Click OK and HMS will delineate the watershed of interest and create sub-basins 

and stream reach structure 
o Export the sub-basin structure as a shapefile: GIS menu -> “Export Georeferenced 

Elements”  
o In ArcMap create a raster version of the sub-basin shapefile using ArcToolbox-

>Conversion Tools->To Raster->Polygon to raster. Both the polygon and the raster 
versions will be needed to estimate parameters in Section 6 below.  

o The user needs to check the HMS basin delineation for accuracy.  Tip: If necessary, 
the user can manually edit the subbasins shapefile in ArcMap.  Then re-open HEC-
HMS and delete only the edited sub-basin elements and re-import the edited sub-
basin shapefile into HEC-HMS using GIS->Import Georeferenced Elements.  Basin 
and Reach characteristics must be recomputed for edited elements using the 
Parameters menu.  

 
• For Clark Unit Hydrograph:  

o HEC-HMS Parameters menu -> Subbasin Area. Lists area size of each subbasin. 
o HEC-HMS Parameters menu -> Characteristics -> Sub-basin. HMS will calculate sub-

basin properties to be used in unit hydrograph parameter calculations (Clark UH 
parameter calculations are described in Section 6 below).  

o The following relevant sub-basin properties are calculated by HEC-HMS:  area, 
longest flow path length, longest flowpath slope, and centroidal flowpath length.  

 
• For Muskingum-Cunge Reach Routing:   

o HEC-HMS  Parameters menu -> Characteristics -> Reach.   HEC-HMS will calculate  



 

 
Colorado Dam Safety Page 16 
Guidelines for Hydrological Modeling and Flood Analysis Rev.  September 12, 2022 

reach properties to be used in routing parameter calculations.  Unit conversions 
will need to be done by the user.  

o The following relevant reach properties are calculated by HEC-HMS: length & slope. 
o Stream reach cross-section geometry must be determined by the user.  Tip: 

transects can be cut from DEM to help estimate channel shape.  

5.3 The final step in Generating Sub-basin Properties is to calculate sub-basin average soil and 
vegetation properties: %sand, %clay, %organic matter, depth to restrictive layer, and fractional 
vegetation cover.  These sub-basin properties can be calculated using the CSU-SMA python 
ArcToolbox, which is provided as a courtesy at the user’s risk and is described in detail in Section 
6, Parameter Estimation.  Before the script calculates the CSU-SMA model parameters, it first 
calculates sub-basin properties using the gNATSCO soils and Fg vegetation raster data.  The CSU-
SMApython script generates the following sub-basin property GIS attribute table output:  
• Sbprop_sand_table: sub-basin average sand fraction, use Mean column [unitless] 
• Sbprop_clay_table: sub-basin average clay fraction, use Mean column [unitless] 
• Sbprop_om_table: sub-basin average organic matter fraction, use Mean column [unitless] 
• Sbprop_dtrl_table, sub-basin average depth-to-restrictive-layer, use Mean column [inches] 
• Sbprop_fg_table, sub-basin average fractional vegetation cover (described above), use 

Mean column [unitless] 
 
As described in the following section the CSU-SMApython script will use these soil and vegetative 
cover properties to calculate HEC-HMS SMA soil loss parameters with pedotransfer functions by 
Saxton & Rawls (2006).    
 
NOTE: The gNATSCO data set has a small fraction of missing data over Colorado, but is 
considered best available information.  The CSU-SMApython script simply ignores missing data 
when calculating sub-basin average properties and model parameters.  We recommend that the 
user view missing data in ArcMap for your basin-of-interest and factor it into your model 
confidence evaluation and calibration.  In some cases it may be possible to use other sources of 
soil data to help estimate sub-basin properties, e.g. US Forest Service soil surveys.    
 

5.4 Sub-basin Properties Reporting Requirements:  Engineers should provide 
the following reporting and quality control checks for sub-basin properties (NOTE: 
see hyperlinks below to supporting spreadsheet tools, provided as a courtesy 

and at the user’s risk. See Example Reporting in Appendix A and Reporting Checklists in 
Appendix C): Tip:  Our recommendation is to perform this reporting step before proceeding to 
Parameter Estimation, such that reporting and checking are completed linearly; reporting 
facilitates subsequent steps in the process.    

5.4.1 REPS PMP Tool Output Reporting (see examples in Appendix A):  
• Print GIS map of cumulative rainfall for each PMP storm type applicable 

to the basin of interest (e.g. 2hr LS PMP, 6hr LS PMP, 24hr LS PMP (Zones 
1 and 3 only), 72hr GS PMP, and 72hr TS PMP (south of 38.5º lat. only)) 

• Print basin average PMP GIS attribute table output for each storm type.  
• Print temporal distribution data and graph the cumulative rainfall 

hyetographs for each storm type (link to spreadsheet tool).  For each 
storm type, only include the temporal distribution(s) used in the analysis 
(e.g. LS 6hr Synthetic West; see REPS guidelines for recommended 
distributions).     

• For each storm type, print PMP_points GIS attribute table output (e.g. 
Local_PMP_Points_basinname_XXsqmi), which shows controlling 
historical storms by duration and location at each grid cell in the basin-
of-interest.  

 

https://drive.google.com/drive/folders/1BSZiRgODwXxi_AvlPn5hwgQrcYaJunl0?usp=sharing
https://drive.google.com/drive/folders/1EfH1hkcY41VxTZk0QFJfIPcadkQ-61Sm
https://drive.google.com/drive/folders/1BSZiRgODwXxi_AvlPn5hwgQrcYaJunl0?usp=sharing
https://docs.google.com/spreadsheets/d/1niUdCrml_ORKIFmvs4jQ6qzS1vLJYr4k/edit?usp=sharing&ouid=115042170524029578776&rtpof=true&sd=true
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5.4.2 REPS MetPortal Precipitation Frequency Output: 
• Print screen image of Frequency Curve with confidence bounds and REPS 

PMP for the same duration, along with the map image of the basin 
shapefile, for each storm type. 

• Print temporal distribution hyetograph image from MetPortal and print 
the temporal distribution data for each storm type (scaled to 10e-2 for 
reporting purposes).   

5.4.3 If Partial Area Analysis is performed based on REPS storm area size limits 
(see Section 4.6 above), include a summary table that shows which sub-basins are 
included and area size for each partial area by REPS storm type (link to sample 
spreadsheet tool)   

5.4.4 Document and report the selected NDVIo and NDVIinf values for basin-of 
interest that were used to calculate fractional vegetative cover (Fg). 

5.4.5 Print the five CSU-SMApython sub-basin property output tables listed above 
in Section 5.3 (Sbprop_sand_table, Sbprop_clay_table, Sbprop_om_table, 
Sbprop_dtrl_table, and Sbprop_fg_table). 

5.4.6 Create a sub-basin properties summary table for reporting and review 
purposes to include the following properties by sub-basin: average %sand, average 
%clay, average %OM, average Depth to Restrictive Layer in inches, and average % 
fractional vegetative cover (obtained from CSU python script output), and from HEC-
HMS: sub-basin area, L (longest flow path), Lca (length of centroid flow path), and slope 
(longest flowpath slope) (link to sample spreadsheet tool).   

5.4.7 Create a stream reach properties table for reporting and review purposes to 
include the following: reach length in feet, reach slope in ft/ft, and stream cross-
section geometry description (Link to sample spreadsheet tool).   

5.4.8 Print GIS maps of the following sub-basin properties (see examples in 
Appendix A): 

• Sub-basin delineation & labels with stream reach structure and labels -- INCLUDE 
PARTIAL AREAS by REPS storm type, if applicable (see Section 4.6 above)  

• Aerial imagery 
• Topographic map 
• Sand fraction 
• Clay fraction 
• Organic matter fraction 
• Depth to restrictive layer 
• Fractional vegetative cover

5.4.9 For QC checking, sub-basin maps and sub-basin property averages should be 
reviewed to determine whether they make physical sense for the basin and region of 
interest. 

https://docs.google.com/spreadsheets/d/1BlZMswCuTA8d-srTXkxEOGpKrgzNKfL_/edit?usp=sharing&ouid=115042170524029578776&rtpof=true&sd=true
https://docs.google.com/spreadsheets/d/1BlZMswCuTA8d-srTXkxEOGpKrgzNKfL_/edit?usp=sharing&ouid=115042170524029578776&rtpof=true&sd=true
https://docs.google.com/spreadsheets/d/1-BtTJEl6JqV0_wSwyovy-Gf5-ulj8s9f/edit?usp=sharing&ouid=115042170524029578776&rtpof=true&sd=true
https://docs.google.com/spreadsheets/d/1ORxJOdkrUpnM5C5lY9THn1HAWRfiwgZn/edit?usp=sharing&ouid=115042170524029578776&rtpof=true&sd=true
https://drive.google.com/drive/folders/1BSZiRgODwXxi_AvlPn5hwgQrcYaJunl0?usp=sharing
https://drive.google.com/drive/folders/1BSZiRgODwXxi_AvlPn5hwgQrcYaJunl0?usp=sharing
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Section 6. CSU-SMA Model Parameter Estimates 

6.1 The CSU-SMA method uses the following elements & methods in HEC-HMS, for which 
parameter estimates are necessary (cross-reference Figure 5 above): 
• Meteorological Model: Precipitation Specified Hyetograph, Annual Evapotranspiration 
• Basin Model: Simple Canopy, Soil Moisture Acccounting (SMA) loss, Clark Unit Hydrograph 

transform, Linear Reservoir baseflow 
• Reach Routing: Muskinghum-Cunge 

6.2 HEC-HMS SMA model loss method parameters can be estimated based on the CSU 
Mountain Hydrology Research Study Phase II (Irvin, 2021).  Irvin (2021) developed soil hydraulic 
properties after Rawls et al (1983), Saxton and Rawls (2006), and Sabol (2008).  CSU and Colorado 
Dam Safety developed a python script named pedotransfer_fn.py and an ArcToolbox named 
CSU_SMApython2, in order to automate HEC-HMS SMA parameter estimation per Irvin (2021).  The 
script is provided as a courtesy, at the user’s risk, and can be downloaded from the following 
DWR Google Drive link:  
https://drive.google.com/drive/folders/1nuF3Oj8UTfgLm7YRZQS4lvKVAJbf69UV?usp=sharing 

Please note the following points about the CSU-SMApython2 ArcTool and python script:  
• The CSU_SMApython2.tbx file, Loss folder, and all files in the folder must be downloaded 
• We recommend saving the files/folder to a local hard drive to run in ArcMap 
• The full script is shown in Appendix B, for transparency.  The downloaded script can be 

edited as-needed using IDLE, with the understanding that Colorado Dam Safety will review 
projects based on our version and significant changes should be documented by the user. 

• Irvin (2021), Rawls et al (1983), Saxton and Rawls (2006), and Sabol (2008) papers are 
provided at the following Google Drive link, for easy reference and transparency: 
https://drive.google.com/drive/folders/1bJBtYHy96ejo1YdS5xosaJi2TsVKto20?usp=sharing 
 

To run the CSU_SMApython2 tool in ArcMap, select “Add Toolbox” in the ArcToolbox window and 
navigate to the downloaded CSU_SMApython2.tbx file.  In the new toolbox, right click on 
CSU_SMApython, select properties, and navigate to the location of the downloaded 
pedotransfer_fn.py script.   Next, double-click on CSU_SMApython to run the ArcTool and the 
following user interface should appear: 

 

https://drive.google.com/drive/folders/1nuF3Oj8UTfgLm7YRZQS4lvKVAJbf69UV?usp=sharing
https://drive.google.com/drive/folders/1YWOYiYQQSP7yojXpv57pjjPCcfNrpQud?usp=sharing
https://drive.google.com/drive/folders/1bJBtYHy96ejo1YdS5xosaJi2TsVKto20?usp=sharing
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Using the dropdowns, select the %sand, %clay, % organic matter (OM), depth to restrictive layer 
input data (all from Section 4.5 above), and Fg fractional vegetative cover raster (from Section 
5.1 above).  Navigate to the HEC-HMS Sub-basin shapefile and then to the Sub-basin raster (both 
from Section 5.2 above).  Navigate to the desired output folder, where the CSU-SMApython script 
will save sub-basin property and parameter output tables (we recommend saving files to the 
user’s local hard drive).  Click OK to run the script.   

First the CSU_SMApython script calculates the following soil hydraulic properties using 
pedotransfer functions from Rawls et al (1983), Saxton and Rawls (2006), and Sabol (2008):   
• Soil water fraction at saturation (theta_s) 
• Soil water fraction at field capacity (theta_33) 
• Soil water fraction at wilting point (theta_1500) 
• Wetting front suction head (psif) 
• Saturated hydraulic conductivity for bare ground in mm/hr (Ksatbare) 
• Saturated hydraulic conductivity adjusted for vegetative cover in mm/hr (Ksat) 
• Max infiltration rate over 3-inch depth using Green & Ampt equation (f)  
• Maximum soil water storage, inches, (S_max)  
• Field capacity water storage, inches, (Si_fld)  
• Wilting point water storage, inches, (Si_wp) 

Next the CSU_SMApython script uses the above soil hydraulic properties to estimate the following 
HEC-HMS SMA loss method parameters. Equations for parameters are shown in Table 4. 
• Max infiltration, in/hr (HMS_maxinfil) 
• Soil percolation, in/hr (HMS_soilperc) 
• Soil storage, inches (HMS_ss) 
• GW1 storage, inches (HMS_GWst) 
• Tension storage, inches (HMS_tens) 
• Initial soil moisture, Soil, % (HMS_InSM) 

 
 Table 4: CSU-SMA parameter equations 

Parameter Pedotransfer Equation 
Max Infiltration Rate  ½*Ksat(1+psif/dwf), dwf=75mm, (Woolridge et al, 2020),  

           where, Ksat=Ksatbare*(1 + (Fg*100 – 10)/90) 
Soil Percolation  ¼*Ksat  
Soil Storage (1-pctgGW)(Smax – Si_wp), pctgGW=0.10, (Koren et al 2000) 
GW1 Storage pctgGW(Smax – Si_wp), (Koren et al, 2000) 
Tension Storage Si_fld – Si_wp,  (Koren et al 2000) 
Initial Soil Moisture (S_fld – Si_wp)/(Smax – Si_wp) 

 
The CSU_SMApython script creates output tables for sub-basin average soil properties (listed in 
Section 5.3 above), and it creates the following output tables for HEC-HMS SMA loss method 
parameter estimates:   
• hms_maxinfil_table [units=in/hr] == HEC-HMS Max Infiltration (in/hr) 
• hms_soilperc_table [units=in/hr] == HEC-HMS Soil Percolation (in/hr)  
• hms_soilstorage_table [units=inches] == HEC-HMS Soil Storage (in) 
• hms_gw1storage_table [units=inches] == HEC-HMS parameter GW1 Storage (in)  
• hms_tensionstore_table [units=inches] == HEC-HMS Tension Storage (in) 
• hms_initialsm_table [units=%] == HEC-HMS Soil (%) 

Navigate to the user-specified CSU_SMApython output folder and load the soil property and SMA 
parameter output tables into ArcMap as attribute tables, then export the tables as text files for 
use in report documentation and to facilitate input to HEC-HMS.    
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6.3 Clark Unit Hydrograph parameters can be estimated using the Dam Safety Branch’s Clark 
UH parameters.xlsx spreadsheet, provided at the following DWR Google Drive link:  
https://docs.google.com/spreadsheets/d/1acY4BqPT50dB_HgfI3rJ3b3ISwHTEjN4/edit?usp=sharin
g&ouid=115042170524029578776&rtpof=true&sd=true 

The CSU-SMA model method calculates Clark UH time of concentration, Tc, per Sabol (2008) for 
generally undeveloped basins in the Rocky Mountains, Great Plains, and Colorado Plateau, as:  

                                         0.1 0.25 0.25 0.22.4c caT A L L S −=  

where   is total sub-basin area, sq mi 
  is longest flowpath length, miles 
  is longest flowpath slope, ft/mile 

 is centroidal flowpath length, miles 
         

Sabol (2008) also provides Tc equations for agricultural and urban basins, which may be 
appropriate for developed basins and sub-basins.  

CSU’s mountain hydrology research estimated the Clark UH storage coefficient parameter (R) 
assuming that the ratio R/(Tc+R) is regionally uniform (Wang and Dawdy, 2012) and within the 
range of 0.6 to 0.8 (i.e., R=1.5Tc to 4Tc) for Colorado’s mountain basins (Dunn et al, 2001; MWH 
Global, 2017).  Wang and Dawdy (2012) suggest that lower ratio values should be used for 
urbanized basins and basins with less hillslope storage (e.g., prairie or canyon lands).  For Front 
Range foothills and canyons, Colorado Plateau canyons, and Eastern Plains, Colorado Dam Safety 
has found that R/(Tc+R) values between 0.2 and 0.3 (i.e. R=0.25Tc to 0.43Tc) may be appropriate.  
It is interesting to note that the Clark UH with R of 0.25-0.43Tc and Tc per the Sabol, 2008 
(equation shown above), agrees well with the USBR Rocky Mountain Thunderstorm unit 
hydrograph (Cudworth, 1989), Kn between 0.5 and 0.8, as recommended previously by Sabol 
(2008).  This seems appropriate because Cudworth developed the USBR RMTS UH from Front 
Range Foothills floods, before the 7,500-ft limit on rain-driven extreme flooding in Colorado’s 
Rocky Mountains was well understood.  The often-reported over-conservatism of the USBR RMTS 
UH appears to have resulted from Cudworth’s extrapolation of its application to high elevation 
mountain terrain in the Rocky Mountains.  The CSU-SMA method and Clark UH parameters 
recommended herein attempt to correct this long-standing problem by using a slower basin 
response for the high mountains above about 7,500 feet elevation and faster response for the 
foothills and canyons below 7,500 feet.           
 
Users should be aware that hillslope storage (represented by R) may not depend on sub-basin size 
as implied by the uniform R/(Tc+R) ratio approach.  CSU tested different sub-basin sizes and 
found that the uniform R/(Tc+R) ratio method did not work well for larger sub-basins, because 
hillslope length does not necessarily increase.  Larger values for R led to lower predictions of 
peak flow and more attenuated hydrographs.  For mountain sub-basins larger than about 10 sqmi, 
CSU found that a constant value of 7 hours for R (based on an average of their mountain test 
basins) worked well (Irvin, 2021), representing average hillslope storage for Colorado mountain 
basins. No similar analysis was done for the foothills, canyons and plains regions; our 
recommendation is to determine Tc and R by Sabol (2008) as a starting point.  However, we have 
found that HEC-HMS’s Clark UH Variable method for estimating Tc and R may help in model 
calibration per Section 10 below, particularly for Front Range foothills and Eastern Plains basins 
(more details in Section 10).  This suggests a non-linear runoff transformation response, with 
increasing speed at increasing rainfall intensity.  As of the issuance of these guidelines, CSU has a 
research study on non-linear unit hydrograph response in Colorado basins.  
 
Table 5 provides a summary of the above Clark UH Tc and R parameter estimation guidelines.  
These estimates should be used as a starting place; Tc and R should be checked and calibrated as 

https://docs.google.com/spreadsheets/d/1acY4BqPT50dB_HgfI3rJ3b3ISwHTEjN4/edit?usp=sharing&ouid=115042170524029578776&rtpof=true&sd=true
https://docs.google.com/spreadsheets/d/1acY4BqPT50dB_HgfI3rJ3b3ISwHTEjN4/edit?usp=sharing&ouid=115042170524029578776&rtpof=true&sd=true
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needed based on reasonableness checks against peak flow envelopes and flood frequency 
estimates, as discussed in Sections 9 & 10 below.   
 
Table 5: Summary of guidance for Clark UH Tc and R parameter estimation by region(1) 

Region Tc, time of concentration (hrs) R, storage coefficient (hrs) 

Mountains > 7,500 ft 
0.1 0.25 0.25 0.22.4c caT A L L S −=         (Sabol, 

2008) 

Sub-basin<10sqmi: R/(Tc+R)=0.6-0.8 
Sub-basin>10sqmi: 7 hours 

Front Range foothills, 
Eastern Plains, and 

West Slope Canyons(2) 

0.1 0.25 0.25 0.22.4c caT A L L S −=  

(Sabol, 2008) 

R/(Tc+R) = 0.2-0.3  
or R=0.37Tc

1.11L0.8A-0.57 (Sabol, 2008) 

Agricultural Tc=7.2A0.1L0.25Lca0.25S-0.2 (Sabol, 2008) R=0.37Tc1.11L0.8A-0.57 (Sabol, 2008) 

Urban/developed Tc=3.2A0.1L0.25Lca0.25S-0.14RTIMP-0.36              
(Sabol, 2008) R=0.37Tc1.11L0.8A-0.57 (Sabol, 2008) 

(1) These estimates should be used as a starting place; Tc and R should be checked and calibrated as 
needed based on reasonableness checks against peak flow envelopes and flood frequency estimates, as 
discussed in Sections 9 & 10 below.  

(2) HEC-HMS’s Clark UH Variable method for estimating Tc and R may help in model calibration per 
Section 10 below 

 
Finally, because of some engineers’ interest in using HEC-RAS 2D for rainfall-runoff 
transformation, several caveats are offered here:  No specific RAS 2D parameter guidelines are 
provided here because it was not used in CSU’s mountain hydrology flood calibration studies.  
The CSU research showed that the unit hydrograph approach is generally adequate for modeling 
historical extreme floods in mountain basins.  However, use of RAS 2D runoff transform may be 
desired for basins with unique topography and may be helpful for modeling non-linear runoff 
response from extreme high-intensity rainfall, similar to HMS’s Variable Clark UH method.  Such 
non-linear response has been indicated by extreme floods along Colorado’s Front Range foothills 
and Eastern Plains.  Users should be aware that 2D diffusion wave runoff may not be a physically 
accurate representation of runoff production in mountain basins, which are notable for their lack 
of surface flow (Larsen et al, 2009; Lin et al, 2008); therefore, RAS 2D model parameters should 
be calibrated to observed floods.  Also, RAS 2D does not currently perform rainfall loss 
calculations; excess precipitation would be calculated in another program, e.g. HEC-HMS.  And 
sub-surface flow, considered to be an important component of mountain basin runoff production, 
would need to be added to RAS 2D generated surface runoff hydrographs.        

6.4 Linear Reservoir Baseflow method parameters are as follows: Reservoirs = 1, Initial Type 
= Discharge, GW1 Initial (cfs)=0, GW1 Fraction = blank, GW 1 Step is 1, and GW Coefficient = 3*R, 
where R is the Clark UH storage coefficient described above.   

6.5 For Muskinghum-Cunge Reach Routing parameters, use reach properties calculated per 
Section 5.2 above using HEC-HMS Parameters->Characteristics -> Reach.  Simple unit conversion 
may be needed.  The user must determine reach cross-section geometry. Transects can be cut 
from the DEM to help estimate channel shape.  

6.6 Table 6 below summarizes all CSU-SMA method HEC-HMS parameters, estimation 
methods, and recommended values, where applicable:  
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Table 6: CSU-SMA method HEC-HMS parameter list, estimation methods, & values 
HMS Method Parameter (units) Parameter estimation method Recommended Parameter 

value 
 

Meteorological Model 
Precipitation 
Specified 
Hyetograph 

Specified Hyetograph 
(NOTE: include 
subbasins=yes) 

See REPS Guidance document for 
creating REPS design storms and 
entering as HEC-HMS Time Series -> 
Precipitation gages 

 

Annual 
Evapotranspiration 

Rate (in/day)         (NOTE: 
include subbasins=yes) 

Use uniform 2-2.5 mm/day (0.079 - 
0.098 in/day), per CSU research 
(Timilsina, 2021) 

0.098 in/day 

 
Basin Model 

Simple Canopy Initial Storage (%) parsimony 0 
 Max Storage (in) Use uniform 4.3 mm (0.169 inch), 

average of north-facing & south-
facing slopes from Cache La Poudre 
site (Woolridge,2019) 

0.169 in 

 Uptake Method  Simple 
Soil Moisture 
Accounting (SMA) 
Loss 

Soil (%) For design storms, base antecedent 
moisture condition (AMC) on 
seasonality of storm type.  In 
general for extreme storms in CO, 
use field capacity (i.e. limit of gravity 
drainage) 

Obtain from CSU-SMApython 
output hms_initialsm_table   
(use mean field) 
NOTE:  CSU Python script 
assumes field capacity.   User 
can edit code for AMC other 
than field capacity. 

 GW1 (%) Parsimony 0 
 GW2 (%) Parsimony 0 
 Max Infiltration (in/hr) Green & Ampt infiltration rate using 

½ Ksat and delta = 75mm (~3 in) 
(Woolridge, 2019) 

Obtain from CSU-SMApython 
output hms_maxinfil_table  
(use mean field) 
  

 Impervious (%) Uniform 5%, based on CSU 
calibrations/verifications, for 
undeveloped mountain basins. 

5% as recommended starting 
place for mountain 
undeveloped basins.  Use other 
methods where appropriate 
(ex. developed basins) and 
calibrate %impervious as 
needed per Sections 9 & 10 
below 

 Soil Storage (in) Allocate 85-95% of total soil water 
storage to soil storage, per CSU 
recommendation 

Obtain from CSU-SMApyhton 
output hms_soilstorage_table 
(use mean field).  CSU-SMA 
script is coded for 90% of 
available storage (10% to GW), 
user can adjust as needed  
 

 Tension Storage(in) Soil water storage between field 
capacity and wilting point 

Obtain from CSU-SMApython 
hms_tensionstore_table (use 
mean field) 
 

 Soil Percolation (in/hr) Use ¼* Ksat, calculated by Saxton & 
Rawls pedotransfer functions. CSU 
used ½*Ksat (Irvin, 2021).  Colorado 
Dam Safety reduced to ¼*Ksat 
based on beta testing to reduce 
subsurface flow 

Obtain from CSU-SMApython 
hms_soilperc_table (use mean 
field) 
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HMS Method Parameter (units) Parameter estimation method Recommended Parameter 
value 

 GW 1 Storage (in) Allocate 5-15% of total soil storage 
to GW1 layer, per CSU 
recommendation 
 

Obtain from CSU-SMApython 
hms_gw1storage_table (use 
mean field).  CSU-SMA script is 
coded for 10% of avail. Storage; 
user can adjust as needed 
 

 GW1 Percolation (in/hr) Uniform try 2.5mm/hr (0.1 in/hr), 
based on CSU 
calibrations/verifications for Front 
Range basins; CSU used 0.5mm/hr 
for San Juan basins. 

0.02 to 0.1 in/hr 
 
Calibrate as needed per 
Sections 9 & 10 below, affects 
losses from system  

 GW1 Coefficient (hr) Use 3 x Clark UH storage coefficient 
(i.e., 3xR)   
 
 

3 x R (from Clark UH*) 
 
*Calculate in Clark UH 
parameters.xlsx spreadsheet.   
 
Calibrate as needed per 
Sections 9 & 10 below 

 GW2 Storage (in) Parsimony 0 
 GW2 Percolation (in/hr) Parsimony 0 
 GW2 Coefficient (hr) parsimony 0 
Clark Unit 
Hydrograph 
Transform 

Method see Section 6.3 and Section 10 Standard or Variable 

 Time of Concentration, Tc 
(hr) 

Use Tc from Sabol (2008) for Rocky 
Mountain, Great Plains & Colorado 
Plateau  or for Urban and 
Agricultural basins 
 
Ref: Sabol (1987) and Sabol (1993). 

See Table 5 above 
 
Calculate in Clark UH 
parameters.xlsx spreadsheet, 
using sub-basin characteristics 
from HEC-HMS (parameters-
>characteristics->sub-basin)  

 Storage Coefficient, R (hr) Use R/(Tc+R) ratio method or R 
from Sabol (2008) – see Table 5 
above 

See Table 5 above 
 
Calculate in Clark UH 
parameters.xlsx spreadsheet, 
using sub-basin characteristics 
from HEC-HMS (parameters-
>characteristics->sub-basin) 

 Time-area Method Use default  HEC-HMS default 
Linear Reservoir 
Baseflow 

Reservoirs (#)  1 

 Initial Type  Discharge 
 GW1 Initial (cfs)  0 
 GW1 Fraction   Blank 
 GW Coefficient Use 3 x Clark UH storage coefficient 

(i.e., 3xR)   
 
 

3 x R (from Clark UH*) 
 
*Calculate in Clark UH 
parameters.xlsx spreadsheet.   
 
Calibrate as needed per 
Sections 9 & 10 below 

 GW1 Steps  1 
Muskingum-Cunge 
Reach Routing 

Length (ft), Slope (ft/ft)  from HEC-HMS Parameters 
menu->Characteristics->Reach  

 Initial Type 
 

 Discharge = Inflow 
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HMS Method Parameter (units) Parameter estimation method Recommended Parameter 
value 

 Mannings n Use literature values  Generally 0.03 – 0.07 for 
mountain streams  

 Index Method  Flow 
 Index Flow (cfs) Use Q-2yr (50% AEP) estimate from 

USGS StreamStats or other bankfull 
flow estimate 

 

 Shape Trapezoid or 8-point, etc., 
depending on channel and available 
data.  Transects from DEM may help 
determine channel/floodplain shape 

 

 

6.7 Parameter Estimation Reporting Requirements:  Engineers should provide the 
following documentation (See example reporting in Appendix A):  

• Summary table of all parameter estimates listed in Table 6 above, by sub-basin 
(link to sample spreadsheet)   

• Print CSU_SMApython output tables for review in order to cross-check against 
HEC-HMS model input:  hms_initialsm_table, hms_maxinfil_table, 
hms_soilstorage_table, hms_tensionstore_table, hms_soilperc_table 
hms_gw1storage_table.  

• Print the completed Clark UH parameters.xlsx spreadsheet   

6.8 Parameter estimates should be reviewed for reasonableness based on sub-basin properties 
(from Section 5) and comparison to USGS StreamStats basin properties, NRCS Web Soil Survey, 
published parameter values, and on basin characteristics and region of study.  Table 7 below 
provides a summary of Green & Ampt parameters -- porosity, wetting front suction head, and 
saturated hydraulic conductivity -- by soil texture (Chow, 1988) for cursory checks of 
CSU_SMApython output.   For example, a back of envelope check can be made where soil storage 
should be roughly equal to porosity for predominate soil texture in each sub-basin multiplied by 
its average depth to restrictive layer.  Clark UH and reach routing parameters can be checked 
against USGS StreamStats basin characteristics. 

Table 7:  Green & Ampt infiltration parameters by soil classification (Chow, 1988) – provided 
ONLY for rough check of CSU_SMApython output 

Soil classification Porosity, n 

Wetting front 
suction head, 

psif (inch) 
Hydraulic conductivity, 

K (inches/hour) 
sand  0.437 1.9 4.64 
loamy sand 0.437 2.4 1.18 
sandy loam 0.453 4.3 0.43 
loamy sand 0.463 3.5 0.13 
silt loam 0.501 6.6 0.26 
sandy clay loam 0.398 8.6 0.06 
clay loam  0.464 8.2 0.04 
silt clay loam 0.471 10.7 0.04 
sandy clay 0.43 9.4 0.02 
silty clay 0.479 11.5 0.02 
clay loam 0.475 12.5 0.01 

 

https://drive.google.com/drive/folders/1BSZiRgODwXxi_AvlPn5hwgQrcYaJunl0?usp=sharing
https://docs.google.com/spreadsheets/d/1aX0k9U07-qzWlx-MqUSExYKsPO1EhlAq/edit?usp=sharing&ouid=115042170524029578776&rtpof=true&sd=true


 

 
Colorado Dam Safety Page 25 
Guidelines for Hydrological Modeling and Flood Analysis Rev.  September 12, 2022 

Section 7. HEC-HMS Model Setup 

7.1 In HEC-HMS a new project with a basin model and terrain data should be created 
(described in Section 5.2 above for purposes of sub-basin delineation and determining sub-basin 
and reach properties).  See Figure 8 below. 

 
Figure 8: Example basin model and terrain setup in HEC-HMS 

7.2 At this point all necessary model parameters have been generated and can be entered into 
the HEC-HMS model.  REPS temporal patterns for input to HMS were discussed in Sections 4 and 5 
above.  SMA loss method, Clark UH, Linear Reservoir Baseflow, and Reach Routing parameters 
have been estimated per Section 6.  The user’s parameter estimation summary table (see Section 
6.6 and Table 6 above) can serve as an easy reference for HEC-HMS model parameter input.  If 
partial area analysis is being done, then the partial area analysis summary table generated in 
Section 5.4.3 above will be useful for model setup.  

7.3 Precipitation Gage Time Series:   

7.3.1 For REPS design storms, the recommendation is to create a Precipitation 
Gage Time Series for each REPS storm (a zero-rain precipitation gage can be created to 
facilitate partial area analysis). Time series should be input in cumulative inches. Table 
8 shows the time interval for each REPS design storm temporal distribution.   

Table 8: REPS design storm time intervals 
Design Storm Temporal Distribution 

Time Interval 
REPS PMP 2-hr, 6-hr and 24-hr Local 

Storms 
5 minutes 

REPS PMP 72-hr GS and TS 15 minutes 
REPS PF LS 5 minutes 

REPS PF MEC 5 minutes 
REPS PF MLC 1 hour 



 

 
Colorado Dam Safety Page 26 
Guidelines for Hydrological Modeling and Flood Analysis Rev.  September 12, 2022 

 

7.3.2 Storm Durations: The recommendation for the CSU-SMA model method is to 
run all 2-hr through 24-hr design storms for minimum 2-day simulation duration and run 
all 48-hr & 72-hr duration design storms for minimum of 10-day simulation duration to 
ensure the full recession limb volume of the hydrograph is modeled, including 
subsurface flow. At the end of the simulation, discharge should be equal or less than 5% 
of the peak flow.  Cumulative precipitation gage time series data must be extended to 
these same durations.  Table 9 shows recommended simulation durations (and thereby 
precipitation time-series durations) by REPS storm type. 

Table 9: Recommended HEC-HMS simulation & precip time-series duration by REPS storm type    
Design Storm Recommended Simulation/ 

Time-series Duration 
REPS PMP 2-hr, 6-hr and 24-hr Local 
Storms 

2 days (2880 minutes) 

REPS PMP 72-hr GS and TS 10 days (240 hours or 14,400 
minutes) 

REPS PF LS 2 days 
REPS PF MEC 2 days 
REPS PF MLC 10 days 
NOTE: At the end of the simulation, discharge should be equal or less than 
5% of the peak flow 

7.3.3 REPS temporal distribution time series can be copied and pasted from REPS 
temporal distribution output text files into the HEC-HMS precipitation gage time series.  
Tip: REPS MetPortal v2.2.0 allows the user to download precip frequency storm 
temporal patterns scaled to all AEPs at once, by storm type. The user must manually 
check the “Download data for all AEPs?” box at the top center of the Temporal Patterns 
page.  

A REPS temporal pattern spreadsheet tool to extend all PF and PMP distributions to the 
recommend time-series durations per Table 9 above can be downloaded from the 
following Google Drive link:  
https://docs.google.com/spreadsheets/d/1HCPFrPRnbK3lt7TuO61BkPR6NaPb8DGR/edit?
usp=sharing&ouid=115042170524029578776&rtpof=true&sd=true 

Tip: For efficiency, in HEC-HMS a single precipitation gage can be created for each time 
increment/duration combination per Tables 8 and 9 above (e.g. 5-minute time interval, 
2 day duration), then this “template” can be copied in HEC-HMS for each applicable 
REPS design storm (e.g. REPS 10e-1 thru 10e-7 AEP LS and MEC and REPS 2hr, 6hr, and 
24hr LS PMP); then each REPS temporal distribution from the temporal pattern 
spreadsheet can be copied and pasted into HEC-HMS.   

Figures 9 and 10 below show example precipitation gage setup in HEC-HMS. 

7.4 Meteorological Model Setup:  A meteorological model should be created for each REPS 
design storm.   

Tip: For efficiency, the recommendation here, based on HEC-HMS 4.7, is to create the first 
meteorological model and setup annual evaporation.  This Met Model can then be copied for 
other storm types. Also, if partial area analysis is being done, then it may be helpful to setup 
each partial area Met Model “template” that can then be copied and edited for other design 
storms that use the same partial area.   

 

https://docs.google.com/spreadsheets/d/1HCPFrPRnbK3lt7TuO61BkPR6NaPb8DGR/edit?usp=sharing&ouid=115042170524029578776&rtpof=true&sd=true
https://docs.google.com/spreadsheets/d/1HCPFrPRnbK3lt7TuO61BkPR6NaPb8DGR/edit?usp=sharing&ouid=115042170524029578776&rtpof=true&sd=true
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 Figure 9: Precip Gage setup   Figure 10: Precip gage time series table 

7.4.1 Evaporation: Enter annual evaporation rate (0.098 in/hr, see Table 6 above) 
for all sub-basins.  Figure 11 shows an example evaporation element setup.   

 
Figure 11: Evaporation->Annual Evapotranspiration setup 
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7.4.2 Specified Hyetographs: Next create a Specified Hyetograph for each REPS 
design storm Met Model, which may be for up to 26 storms, depending on the basin 
location (2hr LS PMP, 6hr LS PMP, 24hr LS PMP, 72hr GS PMP, 72hr TS PMP, and 10e-1 
through 10e-7 AEP for LS, MEC and MLC PF storm types).  Figure 12 shows an example of 
the recommended Met Model setup for all REPS design storms.  Figure 13 shows an 
example Met Model Specified Hyetograph setup for partial area analysis (note the use of 
a zero precipitation rain gage for sub-basins outside of a partial area analysis).   

NOTE: Alternatively, instead of creating a unique Precipitation Gage Time Series and 
Met Model for each of the 21 REPS Precipitation Frequency storms, a single Met Model 
could be created for each storm type using its REPS MetPortal unscaled temporal 
pattern. Then it can be scaled by the PF best estimate per AEP in each HEC-HMS 
simulation run.  This “simulation scaling” approach may save time during model setup, 
but tends to be more difficult in terms of model analysis and documentation.   

Lastly, using the recommended approach of creating a Met Model for each REPS storm, 
then the HEC-HMS simulation precip scaling can be used for the required 1.07 
atmospheric moisture factor from State Dam Safety Rule 7.2 (see Section 10.2 below for 
more discussion on how to use the AMF).   

            
Figure 12: Example REPS design storm 
meteorological models  

Figure 13: Example Met Model Specified 
Hyetograph setup for partial area analysis 
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7.5 Basin Model Setup:  

7.5.1 Sub-basin elements.  Each sub-basin element in the HEC-HMS model should 
be set to the following methods: Canopy method = Simple Canopy, Loss Method = Soil 
Moisture Accounting, Transform method=Clark Unit Hydrograph, and Baseflow 
Method=Linear Reservoir (see Figure 14 below)  Tip: These can be set as defaults in 
HEC-HMS under Tools->Program Settings-> Defaults.  The user’s parameter estimation 
table (see Section 6.6 and Table 6 above) will facilitate easy parameter input.  Figures 
15-18 below show example parameter inputs for each method. 

       
                     Figure 14: Sub-basin element settings Figure 15: Simple Canopy Method, example 

parameters 
 

   
                Figure 16: SMA Method, example parameters Figure 17: Clark UH transform Method, example 

parameters 
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Figure 18: Linear Reservoir Baseflow Method, example parameters 

 

7.6 HEC-HMS Control Specs: Table 9 above showed recommended simulation durations in order 
to ensure hydrograph recession limb and volumes are simulated completely, including subsurface 
flow from the SMA method.  In general, two control specifications should be sufficient:  General 
Storms (10-day duration) and Local Storms (2-day duration).  The recommended simulation time 
interval is 5 minutes for General Storms and 1 minute for Local Storms.  

7.7 Quality Control Check:  There is a large amount of HEC-HMS model input data between the 
CSU-SMA method and REPS design storms.  The model should be thoroughly QC checked by the 
user.  Sub-basin property summary tables (Section 5 above) and parameter summary tables 
(Section 6) will facilitate QC checking.  HEC-HMS Standard Reports can also be helpful for 
efficiently checking all model elements.  As the REPS rainfall inputs require numerous steps and 
manipulations, please check precipitation amounts, time intervals, applied sub-basins (for partial 
area analysis), etc. in HEC-HMS Precip Gages and Met Models. 
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Section 8. HEC-HMS Output and Report Documentation 

8.1 In HEC-HMS a simulation run for each REPS design storm should be executed (in the 
Compute tab) using the correct basin model, meteorological model, control specifications, and 
precipitation ratio (if applicable).  Tip: HEC-HMS allows multiple simulation runs simultaneously 
(under Compute->Multiple Compute), which can be helpful with up to 26 REPS design storms.     

8.2 HEC-HMS output for hydrology reporting should be provided to Colorado 
Dam Safety, for review, as part of a comprehensive report, documenting the 
modeling effort, reasonableness checks (Section 9) and model calibration 

(Section 10).  HMS output reporting should be based on the final model results, following 
calibration.  The following HMS output should be included (See example reporting in 
Appendix A):  

8.2.1 In HEC-HMS, print a summary report under Tools->Reports->Standard 
Reports. Due to the large number of REPS storms and large size of the Standard Reports, 
the recommendation is to print only the Standard Report for the inflow design flood 
(IDF) for design flood studies, or in the case of a hydrologic risk study (where there is no 
design flood), print the dam overtopping (or other relevant hydrologic failure mode) 
REPS precipitation frequency event.  The following output options should be selected for 
the Standard Report (see Figure 19 below):  Global Parameter Summary Tables -- 
Subbasin, Reach; Element Parameter Summary Tables -- Subbasin, Sink; Element Time 
Series Graphs -- Baseflow, Cumulative Precipitation, Cumulative Precipitation Loss, 
Direct Runoff, Precipitation Loss, Saturation Fraction, Soil Infiltration, and Soil Storage. 

 
Figure 19:  Recommended output options for HEC-HMS Standard Report 

https://drive.google.com/drive/folders/1BSZiRgODwXxi_AvlPn5hwgQrcYaJunl0?usp=sharing
https://drive.google.com/drive/folders/1BSZiRgODwXxi_AvlPn5hwgQrcYaJunl0?usp=sharing
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8.2.2 Using HEC-DSSVue or other graphing software, the 
following reservoir inflow hydrographs should be generated and 
included in the hydrology report:  

• All AEPs and PMP reservoir inflow hydrographs overlaid on a single graph for each 
REPS storm type  

• 10e-4 AEP reservoir inflow hydrographs for all storm types (LS, MEC, MLC) 
• PMF inflow hydrographs for all applicable storm types (2hr LS, 6hr LS, 24hr LS, 

72hr GS and 72hr TS)   

8.2.3 Modeled peak flow frequency curves (reservoir inflows) should be plotted 
for all REPS precipitation frequency storms, along with flood frequency curves from 
USGS StreamStats estimates and applicable site-specific and/or regional stream gage 
flood frequency analyses (see Sections 9 & 10 for more details).  Modeled REPS PMF peak 
flows should be overlaid as horizontal lines.  An example plot is shown in Figure 20.  A 
sample spreadsheet for presentation of peak flow frequency curves can be downloaded 
for use from the following Colorado Dam Safety Google Drive link: 
https://docs.google.com/spreadsheets/d/1e53m0RrJTF-
NSYzNlOhxhbfnMDzaaLGo/edit?usp=sharing&ouid=115042170524029578776&rtpof=true&s
d=true 

 

 
Figure 20: Example flood frequency curves plot comparing modeled REPS AEP and PMF peak flows to 
USGS StreamStats and stream gage flood frequency curves.  
 

https://docs.google.com/spreadsheets/d/1e53m0RrJTF-NSYzNlOhxhbfnMDzaaLGo/edit?usp=sharing&ouid=115042170524029578776&rtpof=true&sd=true
https://docs.google.com/spreadsheets/d/1e53m0RrJTF-NSYzNlOhxhbfnMDzaaLGo/edit?usp=sharing&ouid=115042170524029578776&rtpof=true&sd=true
https://docs.google.com/spreadsheets/d/1e53m0RrJTF-NSYzNlOhxhbfnMDzaaLGo/edit?usp=sharing&ouid=115042170524029578776&rtpof=true&sd=true
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8.2.4 Reservoir inflow, reservoir stage, and reservoir outflow 
hydrographs from HEC-HMS should be plotted for 10e-4 AEP floods (all 
storm types) and for PMF floods (all storm types). 

8.2.5 For hydrologic risk analysis of existing dams (see Flowchart 1 at the 
beginning of these guidelines), reservoir stage probability curves (a.k.a., hydrologic 
hazard curves) should be plotted for all REPS precipitation frequency storms.  REPS 
PMF peak reservoir stages should be overlaid (as horizontal lines) along with pertinent 
dam features (e.g. spillway crest, dam crest).  The sample flood frequency curve 
spreadsheet (see Section 8.2.3 above) includes a worksheet for graphing reservoir stage 
probability curves. An example plot is shown in Figure 21 below.  Other probability 
curves may be warranted depending on credible potential failure modes (e.g. spillway 
unit discharge probability curves for a spillway erosion PFM).  
   

 
Figure 21: Example reservoir stage probability curves plot comparing modeled REPS AEP and PMF 

storms and relevant dam features. 

8.3 HEC-HMS results should be reviewed by the engineer for the following:  
• Calculate and tabulate the runoff coefficient for each design storm, which can be 

calculated as runoff volume divided by rainfall volume.  CSU (Irvin et al, under review) 
found runoff coefficients averaged around 30% in their mountain hydrology research,for 
the studied historical extreme storms, which were around 1/100 AEP magnitude events 
(note: two large volume general storms produced runoff coefficients around 60-70% and 
one very localized, extreme thunderstorm, 15%).  Runoff coefficient values generally 
increase with high rainfall intensities (relative to basin soil infiltration capacities), higher 
initial soil moistures, and with larger precipitation volumes (Niemann and Eltahir, 2004). 
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For example, Colorado Dam Safety has found that runoff coefficients may be as high as 
80-90% for Local Storm PMF, modeled by the methods herein. 

• Compare baseflow and direct runoff hydrographs to determine which is dominant.  Also 
compare timing of baseflow and direct runoff peaks and the total hydrograph.  They 
should generally combine to form a steady rising limb, single peak, and then steady 
recession limb, based on CSU’s review of observed flood hydrographs in Colorado 
mountain basins.   

• Review saturation fraction for larger volume design storm events.  Saturation fraction of 
85% and above is assumed to cause saturation excess runoff (Woolridge, 2019).  
Saturation-excess runoff may be indicated when the direct runoff hydrograph peak aligns 
with the soil saturation fraction peak (as shown in HEC-HMS Standard Reports).  Below 
85%, surface runoff is considered to be infiltration-excess, in which case the direct runoff 
peak is expected to align closely with maximum rainfall intensity.  Saturation-excess 
verses infiltration-excess runoff mechanisms should be reviewed for reasonableness 
based on basin properties, storm type, storm AEP/magnitude, etc.  In general, short-
duration intense thunderstorms are expected to result in lower saturated fractions and 
infiltration-excess runoff.  Longer duration, larger magnitude storms may result in 
saturation fractions above 85% and saturation-excess runoff, depending on soil properties 
and soil water storage volume.  Saturation-excess runoff may result where soil storage 
volume is low and infiltration rates are high (i.e. thin, coarse-grained soils) or conversely 
for fine-grained soils where infiltration rates may be low but tension storage and initial 
soil moisture are relatively high. 
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Section 9. Reasonableness Checks & Confidence 

9.1 Extreme flood estimates for dam safety evaluation and design in Colorado traditionally 
have been determined by extrapolation of uncalibrated rainfall-runoff models, often yielding, in 
the mountains and Western Slope, flood estimates several orders of magnitude larger than the 
largest observed floods.  However, Robert Jarrett (USGS) and others have cited a lack of 
paleoflood and historical evidence for such extreme floods in Colorado’s Rocky Mountains.  

In order to address this problem, we introduce the concept of reasonableness here, as referring 
to the situation where watershed model flood-frequency outputs of flood peaks and volumes for 
a range of AEPs are consistent with site-specific or regional flood-frequency statistics for 
hydrologically similar watersheds, and watershed model parameter values are consistent with 
parameter values obtained for hydrologically similar watersheds in the region where good 
calibration was obtained between watershed model outputs and observed streamflows.  More 
generally, watershed model flood outputs and watershed model parameters are consistent with 
historical data in the region. 

The intent of the reasonableness checks step here is to ground rainfall-runoff model 
estimates in the reality of the historical flood record.  As stated in Bulletin 17C, Guidelines for 
Determining Flood Flow Frequency (England et al, 2019): 

Over the past several decades, historical data and information have been shown to be 
extremely valuable in flood frequency analysis (Leese, 1973; Condie and Lee, 1982; 
Stedinger and Cohn, 1986, 1987; Cohn and others, 1997; England and others, 2003a). 
Dalrymple (1960) notes the following: “Historical floods provide probably the most 
effective data available on which to base flood frequency determinations, and where the 
data are reliable, this information should be given the greatest weight in constructing 
the flood frequency graph.” Historical flood information should be obtained and 
documented whenever possible. Use of historical data assures that estimates fit 
community experience and improves the frequency determinations. This information is 
valuable in flood frequency analysis because it directly contributes extreme flood data on 
low annual-exceedance probability floods. 

Further, Waltemeyer (2008), talking about regional envelopes of observed flood peaks, said they 
can “serve as a guide to the reasonableness of flood frequency estimates for large recurrence 
intervals.”  

As stated in Section 1 above: uncalibrated rainfall-runoff model results, per Sections 4 through 8 
above, are viewed here only as a starting point, and reasonableness of such results should not be 
assumed.  Checking and calibrating model results against the historical flood record is considered 
to be an integral step in these guidelines.  Only after these checks are done do we consider the 
model to provide a best-estimate of flooding.  At the same time, confidence is built through the 
reasonableness checks process. Some dams and basins may have a large amount of site-specific 
historical flood information, which makes a case for strong confidence in calibrated model 
results.  Other basins may have very little flood information and may rely on regional data sets.  
Regardless, we have found that the process of gathering available historical flood information 
yields more defensible hydrology results. 

Engineers should use multiple lines of evidence to make the case for reasonable design floods -– 
using gaged floods, indirect flood measurements, anecdotal flood records, and paleoflood 
studies.  Regional flood frequency methods, like USGS StreamStats, can be used as well as stream 
gage flood frequency analyses by Bulletin 17C (England et al, 2019).  Historical floods can be 
researched using SEO Dam Safety files, newspaper archives, Colorado State University’s Extreme 
Storm Precipitation Data Study, #97-1 (McKee and Doesken, 1997), the USGS Colorado Flood 
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Database, etc.  These data can be plotted on regional peak flow envelope curves, along with 
plotting modeled REPS probabilistic and REPS PMF peak flows, and on flood frequency curve plots 
comparing simulated REPS flood frequency curves with USGS StreamStats and Bulletin 17C stream 
gage flood frequency curves. The reasonableness checks discussed in this section tend to 
emphasize discharge, not runoff volume.  Peak flow is generally considered to be more difficult 
to model correctly (and it typically controls spillway design in Colorado). Volume is thought to 
follow from simulating the correct controlling REPS storm type(s), which is addressed by several 
of the reasonableness checks below.   

The following sub-sections provide guidance on specific reasonableness checks.   Also see 
Appendix A for Example Reasonableness Checks summary reports and Appendix C for a 
Reasonableness Checks template.  

9.2 Stream Gage Flood Frequency Analysis:  Many stream gages are or have been operated in 
Colorado, by the USGS, DWR, Mile High Flood District, and others.  If the basin of interest is 
gaged with a minimum of 10 years of non-zero annual peak flows, then flood frequency analysis 
should be performed and plotted as a check of modeled REPS design storm flood frequency 
curves, assuming AEP neutrality, i.e., the simplifying, but useful, assumption that a given AEP 
rainfall event produces the same AEP flood peak.  1/10, 1/100, 1/1000, etc. AEP flood frequency 
estimates can be estimated using USGS Bulletin 17C (England et al, 2019) methods and then 
compared to modeled REPS probabilistic design storms.  Longer periods of record will result in 
stronger confidence.  Flood frequency estimates beyond 1/1000 AEP may be possible if paleo-
flood estimates are available.  The USGS PeakFQ and USACE HEC-SSP computer programs are 
helpful for flood frequency analysis.  (NOTE: Caution and additional research is needed for 
stream gages with missing peak flows, which may indicate that a large flood peak exceeded a 
gage discharge rating or that the gage was damaged by a large flood).  Bulletin 17C analysis by 
programs such as PeakFQ provide 90% confidence bounds on flood frequency estimates. For 
purposes of these guidelines, REPS modeled peak flows that are closer to Bulletin 17C flood 
frequency best estimates are considered to be more defensible, but may vary within 90% 
confidence bounds on flood frequency estimates, if corroborated by additional lines of evidence. 

If the basin or site of interest is ungaged, then flood frequency analysis can be performed for 
stream gages at hydrologically similar locations in close proximity, if possible.  Then the resulting 
flood frequency estimates can be transpositioned to the site of interest using  the drainage area 
ratio (DAR) method or more generally, a ratio of regional peak flow predictor equations like 
those by Capesius and Stephens (2009) or Kohn et al (2016).  Asquith and Kohn (2022) suggest 
that the following DAR equation and area ratio exponents may be reasonable over area ratios of 
0.25 to 2.0, with increasing caution beyond area ratios of 0.5 to 1.5:   

     QT(u) = QT(g) (Au/Ag)x 

 where, QT(u) is the unknown but desired flood frequency discharge (cfs) at an ungaged site 
for T-year average recurrence interval (ARI) 

  QT(g) is the Bulletin 17C flood frequency discharge at a gaged site for T-year ARI 
  Au is the drainage area in square miles at ungaged site 
  Ag is the drainage area in square miles at stream gage 

x is the average exponent for drainage area, by region  Front Range Foothills~=0.6 
and Eastern Plains~=0.33 (Kohn et al, 2016)*.   

 
* Kohn, et al (2016) provides specific area exponents by flood AEP. Note that fractional exponents are an 
indication of partial area contribution during flood events (Asquith and Kohn, 2022). 
 
Furthermore, Kohn and Asquith (2022) suggest that a more generalized ratio of regional peak 
flow predictor regression equations like those by Capesius and Stephens (2009) or Kohn et al 
(2016) is another reasonable method to transposition or rescale Bulletin 17C stream gage flood 

https://drive.google.com/drive/folders/1BSZiRgODwXxi_AvlPn5hwgQrcYaJunl0?usp=sharing
https://drive.google.com/drive/folders/1EfH1hkcY41VxTZk0QFJfIPcadkQ-61Sm?usp=sharing
https://drive.google.com/drive/folders/1EfH1hkcY41VxTZk0QFJfIPcadkQ-61Sm?usp=sharing
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frequency estimates, after the following example using area, precipitation, and slope as 
predictors: 
     QT(u) = QT(g) (Au/Ag)x(Pu/Pd)y(Su/Sd)z 

where,  QT(u) is the unknown but desired flood frequency discharge at an ungaged site 
for T-year ARI 

 QT(g) is the Bulletin 17C flood frequency estimate at a gaged site for T-year 
ARI. 

 A, P and S are example predictor variables (area, mean annual precipitation, 
and main channel slope) at u, the ungaged site, and g, the gaged site. 

 x, y and z are exponents on the predictor variables from a regional peak flow 
regression equation* of the form QT=Ax P y Sz 

 
*Specific regional peak flow regression equations for Colorado by flood AEP and by region, along with valid 
ranges of predictor variables can be found in Capesius and Stephens (2009) and Kohn et al (2016).  Use of 
the regression equations outside of the listed ranges will increase uncertainty.  Note that the USGS plans to 
publish a new report in 2023 that will supersede Capesius and Stepens (2009) for the region west of the 
Front Range and will result in small improvements to peak flow equations.   
 
 
Lastly, regional stream gages for multiple basin sizes can be used to define a regional flood 
frequency curve for a given AEP (e.g. 1/100) on a peak flow vs. drainage area graph, which then 
can be compared to REPS AEP model results for the basin-of-interest.   
 
In terms of uncertainty for transpositioned or rescaled flood frequency estimates and for regional 
flood frequency curves, errors may generally be on the order of 1/4 to 1/3 log10 cycle, 
consistent with historical peak flow regression studies in Colorado (Asquith and Kohn, 2022). 
Again, for purposes of these guidelines, REPS modeled peak flows that are closer to flood 
frequency best estimates are considered to be more defensible, but may vary within 90% 
confidence bounds on the flood frequency estimates, if corroborated by additional lines of 
evidence.    

9.3 Regional Regression Flood Frequency Methods:  In conjunction with stream gage data, USGS 
StreamStats peak flow estimates should be determined for the basin-of-interest:  
https://streamstats.usgs.gov/ss/ 

USGS StreamStats provides regional regression equation flood frequency estimates, for 1/2 (i.e., 
50%) through 1/500 (i.e., 0.2%) AEP.  Generally, USGS StreamStats flood frequency curves can be 
extrapolated to 1/1000 AEP for our purposes and then compared to modeled peak flows from 
REPS probabilistic design storms.  As discussed in the previous section, use of USGS StreamStats 
for basins outside of the range of predictor variables found in Capesius and Stephens (2009) and 
Kohn et al (2016) will decrease confidence.  And again, a new USGS report is expected in 2023 
that will result in small improvements to regional regression equations and minor changes to 
peak flow estimates. In terms of uncertainty, USGS StreamStats provides average standard error 
of prediction in percent (ASEp) for their regional regression equations after Capesius and 
Stephens (2009) and Kohn et al (2016).  USGS StreamStats ASEp may best be considered 
qualitatively in terms of confidence (personal communication with Mike Kohn, USGS) (see Section 
9.11 herein for more on confidence), in that some regions have larger ASEp than others and ASEp 
generally, but not always, increases for rarer AEPs.  If desired, USGS StreamStats ASEp can be 
converted to native log10 space, in which regional peak flow regressions are done, using Table 10 
below, and then used to calculate approximate 90% confidence bounds (Asquith and Kohn, 2022 
and personal communication with Mike Kohn, USGS).  For example, USGS StreamStats gives a 0.2-
percent AEP flood best estimate of 14,100 cfs for an example basin in the Plains Region and ASEp 
of 170%, which equates to about 0.51 log cycle, using Table 10.  Therefore, approximate 90% 
confidence bounds on the USGS StreamStats best estimate would be 4,360 cfs and 45,630 cfs 
(10^(log10(14,100)±0.51).   Confidence bounds on regional estimates may be quite large,  

https://streamstats.usgs.gov/ss/


 

 
Colorado Dam Safety Page 38 
Guidelines for Hydrological Modeling and Flood Analysis Rev.  September 12, 2022 

 
Table 10 Relation of standard error (ASEp,%) to Log10 cycle (from Tasker, 1978) 

Log10 
cycles ASEp (%)

Log10 
cycles ASEp (%)

Log10 
cycles ASEp (%)

Log10 
cycles ASEp (%)

Log10 
cycles ASEp (%)

Log10 
cycles ASEp (%)

0.01 2.3 0.11 25.7 0.21 51.3 0.31 81.5 0.41 120 0.51 172

0.02 4.6 0.12 28.2 0.22 54.1 0.32 84.9 0.42 124 0.52 179

0.03 6.9 0.13 30.6 0.23 56.9 0.33 88.4 0.43 129 0.53 185

0.04 9.2 0.14 33.1 0.24 59.8 0.34 92 0.44 134 0.54 192

0.05 11.6 0.15 35.6 0.25 62.7 0.35 95.6 0.45 139 0.55 199

0.06 13.9 0.16 38.1 0.26 65.7 0.36 99.4 0.46 144 0.56 207

0.07 16.2 0.17 40.7 0.27 68.7 0.37 103 0.47 149 0.57 214

0.08 18.6 0.18 43.3 0.28 71.8 0.38 107 0.48 155 0.58 223

0.09 20.9 0.19 45.9 0.29 75.0 0.39 111 0.49 160 0.59 231

0.1 23.3 0.2 48.6 0.3 78.2 0.4 116 0.5 166 0.6 240  

but as stated in the previous section, for purposes of these guidelines, modeled peak flows that 
are closer to flood frequency best estimates are considered more defensible.  Modeled peak 
flows should in all cases lie within 90% confidence bounds; significant differences from flood 
frequency best estimates should be supported by additional lines of evidence.    

If a basin is gaged with a minimum of 10 years of non-zero peaks, then Bulletin 17C flood 
frequency estimates (Section 9.2) will generally have smaller uncertainty and should be given 
more importance than USGS StreamStats for checking against modeled peak flows.  

9.4 Review of Historical and Paleo-Floods:  Much can be learned by investigating historical 
floods in the basin or region of interest.  Newspaper archives and local historical societies are 
good sources.  Colorado Dam Safety files often have records of noteworthy floods at existing 
dams.  Many dams in Colorado are 100-years old or older, providing a good record of historical 
flooding.  Colorado State University’s Extreme Storm Precipitation Data Study, Report #97-1 
(McKee and Doesken, 1997), the USGS Colorado Flood Database, and REPS Summary Report 
Volume II provide good inventories of historical floods (DWR Google drive link to historical flood 
documents).  These documents do not include all Colorado flood information; the user is 
encouraged to do further research as needed to build a record of historical flooding for the 
basin/region of interest. 

Paleo-flood studies, as a sub-set of historical floods, are particularly useful in providing upper 
limits of the largest floods that have occurred over hundreds to thousands of years (Jarrett and 
Tomlinson, 2000).  Paleo-flood studies use physical evidence to provide valuable information 
about historical or ancient flooding at a site.  The information can be non-exceedance thresholds 
or maximum flood stages.  Paleo-flood indicators can include gravel bars, terraces, high water 
marks, flood scarring, etc.  Dating methods include dendrochronology, radio-carbon, or relative 
dating techniques.  Site-specific paleo-flood studies will only be feasible for the most advanced 
hydrology studies for large, complex projects.  Fortunately, many existing regional paleo-flood 
studies are available in Colorado by the USGS, USBR, USACE and others, in scientific literature.  
The USGS Colorado Flood Database (discussed in detail below) contains paleo-flood estimates and 
links to studies by USGS.   

Modeled reservoir stage probability curves (see Section 8.2.5 above) should be checked for 
consistency with the historical record at existing dams, in terms of controlling storm/flood types, 
record stage, frequency of spillway activation, past dam overtopping incidents, etc.  Modeled 
REPS floods should be checked against historical flood peak flows, durations, storm types, and 
time of year, for consistency with observed flooding.    

 

https://drive.google.com/drive/folders/1L62SwtJvRDwZMR1UVkZjFkAjbywaT7Qc?usp=sharing
https://drive.google.com/drive/folders/1L62SwtJvRDwZMR1UVkZjFkAjbywaT7Qc?usp=sharing
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9.5 Event Calibration:  For more advanced studies, flood reconstruction modeling of historical 
storms/floods can be performed.  For historical storms used in the REPS PMP study (see REPS 
Summary Report Vol. II, Table 2, for a list of storms) Colorado Dam Safety may have access to 
hourly rainfall raster data for event calibration.  Other historical storms (i.e. not used in REPS) 
that occurred in a basin-of-interest can often be reconstructed by consulting meteorologists.  
The sources listed in Section 9.4 above may be useful for identifying historical storms/floods in a 
basin-of-interest for event calibration.  USGS, DWR, and other stream gage data sets can be 
reviewed to determine whether historical flood hydrograph data are available.    

9.6 Controlling Storm Type: Modeled controlling REPS storm type(s) should be compared to the 
storm/flood type(s) of historical flooding for the basin or region of interest.  Information on 
storm types of observed, historical floods can be discerned from flood reports, date/season of 
occurrence, flood duration, and stream gage hydrographs.  Users are reminded that REPS PMP 
storm types are Local Storm (2hr, 6hr and 24hr hybrid, with the latter applicable only to the 
Eastern Plains and Front Range foothills), General Storm (72hr) and Tropical Storm (72hr, 
applicable only south of 38.5º latitude); and REPS MetPortal precipitation frequency storm types 
are LS(2hr), MEC (6hr) and MLC(48hr). Flood frequency curve and reservoir stage probability 
curve plots (see Sections 8.2.3 and 8.2.5 above) depict controlling REPS storms type(s) over the 
range of AEP and PMP magnitudes.   

Controlling storm type can vary due to non-linearities in basin hydrology and due to attenuation of 
inflow floods by reservoir routing. Table 11 is offered as initial guidance in identifying likely 
controlling storm type by region and basin area size.  
 
  Table 11 - Likely Controlling Storm Type by Region and Watershed Size for Extreme Storms 

Likely Controlling Storm Types by Region & Watershed Size for Extreme Storms 

Flood Region 
Nominal                          

Watershed Size                  
(sq mi) 

Likely Controlling               
Storm Type Comments 

Western 
Colorado & 
Mountains              

above 7500 Ft 

watershed < 50 LS 
Areal coverage of LS and MEC storms                  
is much smaller than in Eastern Plains                    

and Front Range foothills <7,500 ft 
50 < watershed < 200 MEC 

Watershed > 500  MLC 

Eastern Plains 
and Front 

Range Foothills                   
below 7500 Ft 

watershed < 100 LS MEC storms may be the controlling 
storm type even when that storm has 

partial areal coverage over the 
watershed. This is due to very high 
unit discharges produced by very 
intense convective precipitation 

100 < watershed < 
1000 MEC 

2500 < watershed MLC 

 

Convective storms (LS and MEC storm types) will typically be controlling for small and intermediate 
sized watersheds in cases where reservoirs have a relatively small volume for flood storage. 
Convective storms will generate higher unit discharges for these watershed sizes than stratiform 
and orographic precipitation produced by the MLC storm type. In these cases, flood peak 
magnitude will be the most important flood characteristic for determining spillway size. The MLC 
storm type becomes the controlling storm type for larger watersheds and watersheds where the 
reservoir has large floodwater storage capacity. In these cases, flood volume and the shape of the 
flood hydrograph in addition to flood peak become important factors for spillway sizing.  Note that 
transition in watershed sizes from the LS to MEC controlling storm type and from MEC to MLC 
controlling storm type likely varies widely, dependent upon watershed-specific characteristics and 
rainfall-runoff modeling parameters.  

9.7 Seasonality of Controlling Storms/Floods:  In Colorado there are strong seasonal aspects to 
rainfall, storm types, and flooding, and these vary by region.  Historical flood and stream gage 
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peak flow records provide information about the seasonality of flooding in a basin or region of 
interest.  CO-NM REPS analyzed seasonality of the largest 50 historical storms of each storm type 
(LS, MEC & MLC) in each of the regions shown below in Figure 22 (northwest, northeast, 
southwest, and Rio Grande); Figures 23, 24, and 25 below show histograms of the resulting 
seasonal distributions of the largest LS, MEC, and MLC storms, respectively, by region (from REPS 
Summary Report, Vol. III, 2018).  Further, REPS Vol. II (PMP), Appendix F, provides the time of 
year for historical extreme storms used for REPS PMP.   

As a reasonableness check of rainfall-runoff model results, the seasonality of the controlling REPS 
storm type(s) (i.e. using model results and Figures 23, 24 & 25) should be checked against the 
seasonality of historical flooding for the basin/region of interest.  This seasonality check may 
help to verify that the model is producing the correct controlling REPS storm type, where the 
actual storm type of historic floods may not be known to the engineer, but the time of year is 
known.  For example, suppose your model for a basin in the Rio Grande region shows the 
controlling REPS storm type is the MLC, which is most likely to occur in September by the last 
histogram in Figure 25.  Looking at regional stream gages, you find that historical peak flows for 
the region typically occur in August or September, consistent with model results.   

    

 

Figure 22: Regions for CO-NM REPS storm seasonality analysis. 

Rio 
Grande 
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Figure 23 (cont’d on next page):   Seasonal distribution of largest 50 Local Storms in each region. Top histogram is 
for north-west region, bottom is for north-east region (cf: Figure 22).  (REPS Vol. III, 2018)  



 

 
Colorado Dam Safety Page 42 
Guidelines for Hydrological Modeling and Flood Analysis Rev.  September 12, 2022 

     

 

Figure 23 (cont’d from previous page):   Seasonal distribution of largest 50 Local Storms in each region.  Top 
histogram is for south-west region, bottom is for Rio Grande region (cf: Figure 22) (REPS Vol. III, 2018)  
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Figure 24 (cont’d on next page):   Seasonal distribution of largest 50 Meso-scale with Embeded 
Convection (MEC) storms in each region. Top histogram is for north-west region, bottom is for 

north-east region (cf: Figure 22) (REPS Vol. III, 2018)  
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Figure 24 (cont’d from previous page):   Seasonal distribution of largest 50 Meso-scale with 
Embedded Convection (MEC) storms in each region. Top histogram is for south-west region, 

bottom is for Rio Grande region (cf: Figure 22) (REPS Vol. III, 2018) 
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Figure 25 (cont’d on next page):   Seasonal distribution of largest 50 Mid-Latitude Cyclone (MLC) 
storms in each region.  Top histogram is for north-west region, bottom is for north-east region 

(cf: Figure 22) (REPS Vol. III, 2018)  
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Figure 25 (cont’d from previous page):   Seasonal distribution of largest 50 Mid-Latitude Cyclone 
storms in each region.  Top histogram is for south-west region, bottom is for Rio Grande region 

(cf: Figure 22) (REPS Vol. III, 2018) 
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9.8 Regional Peak Flow Envelope Curves & USGS Colorado Flood Database:   

9.8.1 Modeled peak flows can be plotted on regional peak flow envelopes as a 
reasonableness check against maximum observed flood discharges.  Peak flow envelopes 
typically plot observed maximum floods -– gaged, indirect (i.e., surveyed after-the-
fact), and paleo-flood estimates –- as a function of drainage area; the plots are typically 
shown in log-log space due to large non-linearities.  Peak flow envelopes have been 
widely used in hydrology literature to examine possible upper limits of flooding and 
regional variations in flood production (Crippen and Bue, 1977; Wolman and Costa, 
1982; Costa, 1987; and O’Connor and Costa, 2004).  Crippen and Bue (1977) divided the 
continental U.S. into 17 regions based on variations in physiography and rainfall 
intensity; Regions 12-14 cover Colorado. Crippen and Bue (1977) then plotted peak flow 
measurements from gaged and indirect discharge measurements from 883 locations and 
defined regional peak flow envelope curves.  O’Connor and Costa (2004) used a data set 
comprised of the top 10% of annual peak discharges from USGS stream gage stations, 
resulting in 35,663 annual peak flows at 14,815 U.S. gages, and then plotted peak flow 
envelopes for 90th percentile and 99th percentile peak flows.  They then mapped the 90th 
and 99th percentile flow locations to show regions that are prone to extreme flooding.  
They concluded such regions have access to atmospheric moisture and have topographic 
relief, causing orographic forcing of rainfall and rapid concentration of streamflow.  
Peak flows that fall into the U.S. 90th percentile have occurred along Colorado’s Front 
Range Foothills and along the Colorado-New Mexico border south of the Raton Mesa and 
in the Republican River basin on Colorado’s Eastern Plains.         

Envelope curves have often been used to guide engineering design (Wolman and Costa, 
1982).  Wolman and Costa (1982) state that envelope curves provide a useful check on 
peak flow estimates, but should not be relied on solely for engineering design because 
of basin-specific variations.  While the curves capture large regional differences based 
on climate and terrain, they do not address basin-scale variations like micro-climates, 
soil variations, basin slope, etc.  Wolman and Costa (1982) also showed that new peak 
flows are increasing the U.S. peak flow envelope more slowly as time goes by and the 
data set of peak flows increases.  They suggested at that time (1982) that the envelope 
may be approaching a physical limit.  Although Crippen and Bue (1977) stated there is 
no statistical return interval associated with peak flow envelopes, an upper physical 
limit is suggestive of the probable maximum flood.  Vogel et al (2007) demonstrated 
possible statistical methods to estimate exceedance probability of a flood of record 
(FOR) envelope using 226 USGS stream gages in the continental U.S. and for an envelope 
of associated PMF estimates (by Nuclear Regulatory Commission) at those same 
locations.  For their data set, they estimated annual exceedance probabilities between 
10e-4 and 10e-6 for the FOR envelope and about 10e-6 to 10e-8 for the PMF envelope.        

The U.S. Bureau of Reclamation uses regional peak flow envelope curves as part of 
hydrologic risk analysis.  Regional envelope curves capture important regional 
differences in flood production across Colorado.  The USBR’s regional peak flow 
envelope used for Colorado’s Front Range (USBR, 2009) is significantly higher than that 
used for the Rocky Mountain inter-mountain region (USBR, 2008).  For example, at 100 
sq mi drainage area size, the USBR’s Front Range envelope peak flow is about 40,000 cfs 
versus about 6,000 cfs for the inter-mountain region envelope (NOTE: these particularly 
2008 and 2009 envelopes are based only on gaged peak flows, not indirect or paleo-
floods).  Alberta, Canada’s Ministry of Transportation (undated) plotted gaged and 
estimated peak flows for six basins on the eastern slopes of the Canadian Rocky 
Mountains, and evaluated several methods of enveloping them.  They concluded that 
Creager envelopes (Creager et al, 1950) did not perform well over the full range of area 
sizes (10 sqkm [3.86 sq mi] to about 100,000 sqkm [38,610 sq mi]), but visually drawn 
envelopes provided a better fit of the data over the range of area sizes.  They caution 
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that envelope curves provide context for an upper range of flows, but that basin runoff 
is a function of many properties besides drainage area.        

9.8.2 Colorado Dam Safety has used the USGS Colorado Flood Database (created in 
cooperation with Colorado Department of Transportation) to develop regional peak flow 
envelopes for Colorado, for the purpose of reasonableness checks of extreme flood 
rainfall-runoff models for dam safety purposes.  Note that in keeping with Crippen and 
Bue (1977), Alberta Ministry of Transportation (undated), and others, Colorado Dam 
Safety’s envelope curves are visually fit to the observed flood data.   

The USGS describes the importance of using historical and systematically collected flood 
data.  The purpose of the USGS Colorado Flood Database is to make low probability 
events in the systematic flood records available to water resources engineers to improve 
flood estimates (Kohn et al, 2013). The USGS Colorado Flood Database includes gaged 
peak flows and indirect-measured peak flows from 1867 – 2015.  The database includes 
flood peaks from many of the same extreme storms that were used to develop REPS 
PMP, e.g., June 1921 on the Arkansas River, May 1935 Cherry Creek, June 1965 
Jimmy Camp Creek, etc.  The USGS Colorado Flood Database is comprised of the 5 
largest gaged peaks that have occurred at each USGS stream gage in the NWIS database; 
indirect measurements that were collected from floods at sites with no stream gage, at 
gaged sites outside of the gaged period of record, or at gaged sites during the period of 
record for stage-discharge rating extension or modification. The database also includes 
peak flow estimates from paleo-flood studies compiled from several peer-reviewed 
papers.  The database currently (2022) includes 6,886 flood events at 1,624 sites in 
Colorado (see Figure 26).  The USGS Colorado Flood Database web address is:  

https://co.water.usgs.gov/projects/COFloodDB/html/COFloodMap.html 
 

Figure 26: General distribution of the 1,624 flood sites included in the USGS Colorado 
Flood Database: https://co.water.usgs.gov/projects/COFloodDB/html/COFloodMap.html 

9.8.3 Colorado Dam Safety mapped the USGS Colorado Flood Database data set 
and experimented with regional groupings that showed similar peak flow limits in terms 
of maximum observed peak flows versus drainage area size.  Three peak flow envelope 

https://co.water.usgs.gov/projects/COFloodDB/html/COFloodMap.html
https://co.water.usgs.gov/projects/COFloodDB/html/COFloodMap.html
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regions were determined using REPS storm transposition zones (Figures 27 & 28): (1) 
Eastern Plains/Front Range Foothills < 7,500 feet elevation (REPS transposition zones 1 
and 3), (2) Mountains >7,500 feet elevation (REPS transposition zones 5, 6 and 9), and 
(3) Western Colorado < 7,500 feet elevation (REPS transposition zones 10, 14, 15, and 
16).  Note that REPS transposition zones 7 (San Luis Valley) and 17 (North Park) were not 
originally analyzed due to the small number of dams (none in zone 7), but peak flows 
there have been checked and found to be consistent with the Mountains Region < 7,500 
ft peak flow envelope region.  The following sub-sections provide a discussion of each 
regional curve. 

 
Figure 27:  REPS PMP storm transposition zones (red) overlaid on terrain. 

 
9.8.3.1 Eastern Plains/Front Range Foothills < 7,500 feet elevation Peak Flow 
Envelope (Figure 29):  This peak flow envelope is by far the most extreme of the 
three Colorado curves.  It covers the highly dynamic weather region that can see 
high moisture influx from the Gulf of Mexico and has steep orographic terrain along 
the Front Range foothills, creating orographic lift and rapid runoff response.  This 
envelope curve is controlled by several of the worst floods in Colorado’s recorded 
history: June 1965 on Kiowa Creek, Plum Creek and Jimmy Camp Creek (one of the 
highest peak flows for its drainage area size in the U.S.); April 1935 on Kiowa 
Creek; and July 1976 on the Big Thompson River. In terms of controlling Storm 
Types versus area size, the July 1976 Big Thompson storm, which generally controls 
the envelope at area sizes less than five square miles, is classified by REPS as a 
Local thunderstorm (REPS Summary Report, Vol. II, App. F).  The July 1965 and May 
1935 storms control the envelope above 50 sq mi.  REPS PMP classifies both of 
these storms as Local/Hybrid storms (i.e., Meso-scale with Embedded Convection); 
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Figure 28:  Colorado Dam Safety peak flow envelope regions:  (1) Eastern plains and Front Range 

foothills < 7,500 feet elevation (blue), (2) Mountains > 7,500 feet elevation (brown), and (3) Western 
Colorado < 7,500 feet (pink) with REPS PMP storm transposition regions outlined and numbered in 
red. Note that REPS transposition zones 7 (San Luis Valley) and 17 (North Park) were not originally 

analyzed due to the small number of dams (none in zone 7), but peak flows there have been checked 
and found to be consistent with the Mountains Region > 7,500 ft peak flow envelope region. 

both were large area events, but included smaller cells of embedded convection 
and high intensity rainfall.  It is worth noting that historical long-duration, low 
intensity PMP General Storms along the Front Range foothills (e.g. Sept. 2013 and 
1969 Big Elk Meadows) do not control the flood envelope.    

USGS paleoflood estimates are included in the USGS Colorado Flood Database, but 
do not control the Eastern Plains/Front Range Foothills envelope. Several dam 
failure peak flows in the database were ignored for purposes of drawing our peak 
flow envelope; the dam breach peak flows stand out as outliers relative to natural 
floods.  Crippen and Bue’s (1977) eastern region (their Region 12) envelope (green 
dashed curve on Figure 29) follows Colorado Dam Safety’s Eastern Plains/Foothills 
envelope well.  This is encouraging, meaning the envelope has not changed 
significantly since 1977.  As noted above, Colorado Dam Safety’s envelope (red line 
in Figure 29) is visually fit to the data.  Finally, observed peak flow data have been 
sub-divided by REPS transposition zone and plotted in different colors to allow the 
user to further compare them to the basin-of-interest.  

9.8.3.2  Mountains > 7,500 feet Elevation Peak Flow Envelope (Figure 30):  This 
envelope covers the orographically-sheltered region of the interior and high 
elevation Rocky Mountains of Colorado, including North Park and the San Luis 
Valley.  This envelope curve is significantly less extreme than that of the 
neighboring Eastern Plains/foothills.  For example, at 100 sq mi drainage area size, 
the Mountain envelope flow is about 10,500 cfs versus about 180,000 cfs for the 
Eastern Plains/foothills envelope.  Jarrett (1989) proposed the elevation limit of 
around 7,500 feet in Colorado’s Rocky Mountains for extreme rainfall-runoff driven 
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flooding, above which, he and others found no paleo-flood or historical evidence of 
extreme rainfall-runoff floods in the past 10,000 years.  The 7,500-foot elevation 
limit has been studied and generally corroborated over the ensuring 30 years.  
USGS StreamStats makes use of it, and the REPS study used it.  The September 
2013 storm and rainfall-driven flooding occurred at high elevations up to the 
Continental Divide, yet the magnitude of the flooding above 7,500 feet was simply 
nowhere near as extreme as record floods at lower elevations along the Front 
Range foothills.  In fact, September 2013 peak flows do not control the peak flow 
envelope for either the Mountains or Plains/foothills regions.   

Colorado Dam Safety’s Mountain Region envelope curve (red line in Figure 30) is 
controlled by the 1976 Big Thompson flood and the 1945 Quartz Creek near Ohio 
City flood at small area sizes (<10 sq mi). At 13.5 sq mi, the envelope is controlled 
by a USGS paleo-flood estimate on Cement Creek near Silverton with a reliability of 
83-1000 years.  At larger area sizes (>50 sq mi) the envelope is controlled by floods 
on the Huerfano River in the Sangre de Cristo range and by the Rio Grande River 
and Vallecito Creek in the San Juan range.  In terms of controlling Storm Types, the 
1976 Big Thompson storm was classified by REPS as a Local Storm.  The September 
1970 flood on Vallecito Creek in the San Juans was a classified by REPS as a General 
Storm (REPS Summary Report, Vol. II, 2018).   

Peak flows from the July 1999 Saguache Creek flood, provide by Dr. Jarrett via 
email, are shown on the Mountain Region envelope plot as grey X’s in order to 
demonstrate the possibility that larger flows at small area sizes may have in fact 
been debris flows (Costa and Jarrett, 1981).  Dr. Jarrett thoroughly investigated 
the Saguache Creek flood after-the-fact and concluded that several sites 
experienced debris flows (email dated March 19, 2021).  He also investigated the 
Quartz Creek near Ohio City flood indicators as part of his doctoral research at 
Colorado State University and concluded that these floods were likely debris flows 
(Jarrett, 1987).  We included the Quartz Creek peak flows in our Mountain Region 
envelope because the USGS Colorado Flood Database recognizes them; however, 
Dr. Jarrett advised that the lower end of our Mountain Region envelope (<1 sq 
mi+/-) may be high and should be used with judgement (verbal communication).  It 
is instructive to note that the Crippen and Bue (1977) envelope for their mountain 
region (Region 13) (green dash on Figure 30) is significantly higher than ours 
(approaching an order of magnitude higher), because Crippen and Bue (1977) 
included peak flow locations below 7,500 feet elevation in their mountain region -- 
their Region 13 envelope is defined by floods in Colorado, Idaho, Montana and 
Wyoming at elevations between about 2,150 ft and 5,310 ft.  At the time they did 
their work (1977), Jarrett's (1989) 7,500-foot limit on extreme rain-driven flooding 
was not generally recognized.   

9.8.3.3  Western Colorado < 7,500 feet elevation Peak Flow Envelope (Figure 31):  
Figure 31 applies to Colorado’s Western Slope below about 7,500 feet elevation, 
including the flanks of the San Juan Mountains, mesas and canyons of the Colorado 
Plateau region, and the Yampa and Green River basins in Northwest Colorado.  In 
comparison to the other two regions, the Western Colorado envelope lies below the 
Mountain Region envelope at small area sizes (<2 sq mi +/-) –- see above discussion 
about debris flows -- then slightly above it at larger area sizes.  The entire Western 
envelope lies far below the Eastern Plain/Foothills envelope.  The Western 
envelope is notably controlled by late-season floods -- August, September and 
October -- in contrast to the other regions.  The seasonality histograms in Figures 
23-25, above, generally show more likely occurrence of late season extreme storms 
in the northwest and southwest regions for all storms types.  At small drainage 
areas (<20 sq mi) the Western Colorado envelope is controlled by August and 
September floods on Piceance Creek near Rio Blanco, Badger Wash near Fruita and  
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Figure 29: Observed peak flows and peak flow envelope for Colorado’s Eastern Plains and Front Range foothills <7,500 feet elevation.  Red line is Colorado Dam 

Safety’s visually estimated envelope; red dotted lines are conceptual 90% confidence bounds (±0.3log10 cycle). 
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Figure 30: Observed peak flows and peak flow envelope for Colorado’s Mountains >7,500 feet elevation.  Red line is Colorado Dam Safety’s visually estimated 

envelope; red dotted lines are conceptual 90% confidence bounds (±0.3log10 cycle). 

*also suitable for REPS Zones 7 and 17 

* 
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Figure 31: Observed peak flows and peak flow envelope for Colorado’s Western Slope <7,500 feet elevation.  Red line is Colorado Dam Safety’s visually estimated 

envelope; red dotted lines are conceptual 90% confidence bounds (±0.3log10 cycle). 
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Red Canyon and No Thoroughfare Creeks near Grand Junction.  The related storms 
were not used for the REPS PMP study, but at such small area sizes it can be 
assumed they were intense, convective storms.  At larger area sizes (>100 sq mi), 
the envelope is controlled by the October 1911 flood on the San Juan River at 
Pagosa Springs.  This storm was a General Storm/Remnant Tropic Storm. 

Crippen and Bue’s (1977) western region (Region 14) envelope is close to our 
Western Colorado envelope, except that the Crippen and Bue curve is higher at 
small drainage area sizes, where theirs is controlled by floods in Arizona, New 
Mexico, and Utah, not Colorado.  It should also be noted that their western region 
(Region 14) includes the Colorado Plateau and western San Juan range, but not 
northwest Colorado, the latter of which they included in their mountain region 
(Region 13).  This may in fact be more appropriate; however, in practice our 
Mountain and Western Colorado envelope curves are reasonably similar.    

 

9.8.4 Using the peak flow envelope curves for reasonableness checks:  Microsoft 
Excel files of Colorado Dam Safety’s Peak Flow Envelope plots can be downloaded from 
the following link to facilitate plotting and comparison of rainfall-runoff model 
discharges:  

https://drive.google.com/drive/folders/1Q_Y6arM0Vd4NomgBB-U4NxTBOZ0zNz-
c?usp=sharing 

The recommended use of Figures 29-31 is to plot all modeled REPS PMP and probabilistic 
peak flows for comparison, along with other reasonableness checks data, discussed 
above, for the basin of interest –- historical flood peak flows, flood frequency estimates, 
etc.  Regional 1/100 and 1/1000 AEP flood frequency estimates should be plotted as 
well.  Figure 32 below shows an example peak flow envelope plot with HEC-HMS REPS 
model results and data from reasonableness checks. 

Our envelope curves are intended to provide a reasonableness check of extreme storm 
rainfall-runoff model results.  In the past, unchecked extrapolation of rainfall-runoff 
models to extreme events appears to have led to design storms that were orders of 
magnitude beyond any observed floods, present or from paleo records.  It is desirable to 
avoid those sorts of gross over-estimates in order to more accurately identify and 
quantify dam safety risks.  That said, the peak flow envelopes shown in red on Figures 
29, 30 and 31 are simply visual fits of the maximum data; they are not intended to imply 
any theoretical function of flood production with respect to drainage area.  Further, 
observed peak flow measurements contain uncertainty; the USGS Colorado Flood 
Database rates its measurements on a qualitative scale of poor, fair, or good.  Many 
extreme flood indirect (after-the-fact) flood discharge estimates are understandably 
rated poor with uncertainties of 25% or more.  We have plotted +/-25% error bounds on 
individual peak flow measurements using “whiskers”  to represent an approximate level 
of discharge measurement error for use in comparing modeled peak flows to individual 
historical floods.  In terms of uncertainty on the envelopes themselves, the envelopes 
are a form of graphical regionalization of a predictive regression model, where inter-
basin variation is a source of model error or uncertainty.  Historically regional predictive 
models for Colorado flood hydrology have uncertainties of 1/4 to 1/3log10 cycle 
(Asquith and Kohn, 2022).  On Figures 29-31 we have plotted 1/3 log10 cycle offsets to 
the envelopes as conceptual 90% confidence bounds for use in comparing modeled peak 
flows to the peak flow envelopes in light of the full scope of regional variation.  
Maximum flood production for a particular basin depends on many factors, not just 
drainage area, so the envelopes are not expected to provide an exact answer.  The 
envelope curves are one tool of the many discussed in this section that can be used to  

https://drive.google.com/drive/folders/1Q_Y6arM0Vd4NomgBB-U4NxTBOZ0zNz-c?usp=sharing
https://drive.google.com/drive/folders/1Q_Y6arM0Vd4NomgBB-U4NxTBOZ0zNz-c?usp=sharing
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Figure 32: Example peak flow envelope with modeled REPS PF and PMF peak flows, as well as data from reasonableness checks.  
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make a case for defensible model results.  See Section 9.11 on confidence and Section 
10 on using confidence to help weight observed flood data for use in model calibration.   

One of the most useful findings of the envelope plots is the regional differences in flood 
yields, particularly between the Eastern Plains/Front Range foothills (Figure 29) versus 
the rest of the state (Figures 30 and 31).  This regional difference has been shown by 
Jarrett (1989) and others, and it is implicit in REPS rainfall estimates via storm 
transposition boundaries.  However, historically, dam safety design flood modeling many 
not have reflected these regional differences.  Figures 33 and 34 below compare our 
three regional peak flow envelope curves in log-log space (Figure 33) and linear space 
(Figure 34).  The linear graph in particular depicts the large regional differences in flood 
magnitudes.  The shortcoming of many past dam safety design flood studies seems to be 
related to erroneous extrapolation/transposition of flooding from the Front Range 
foothills/Eastern Plains to the rest of the state.   

 

 
Figure 33:  Comparison of Colorado Dam Safety’s three regional peak flow envelope curves in log-log space. 
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Figure 34: Comparison of Colorado Dam Safety’s three regional peak flow envelope curves in linear space. 

 
 
Finally, Figure 35 plots regional 1/100 AEP flood frequency estimates from USGS 
StreamStats and from Bulletin 17C, along with the USGS Colorado Flood Database 
observed peak flows, for our Mountains region >7,500 feet.  There is a moderate amount 
of scatter in the 1/100 AEP flood estimates, indicative of basin-specific variation, but in 
general they make a linear trend in log-log space, consistent with a power-function 
relationship between flood production and drainage area.  In contrast, the observed peak 
flows and our envelope level off at larger drainage area sizes, say above around 75 sq mi.  
This may be because there are fewer large basins, and so the sample size of peak flows is 
smaller at larger areas. The plot suggests that the peak flow envelope may not 
correspond to a uniform return interval and may increase in likelihood of exceedance 
with increasing area size.  If this is the case, then the envelope curves may not represent 
an upper limit at larger area sizes.  On the other hand, Crippen and Bue (1977) and 
Wolman and Costa (1982) used non-linear log-log envelopes like ours, and they do not 
indicate a significant or larger increase in the curves at larger area sizes since at least 
1948.  Research by Laurenson and Kuczera (1999) and Nathan et al (2016) on notional AEP 
of PMP (i.e., the likelihood corresponding to estimates of flood upper limits) calculated 
lower notional AEP of PMP for smaller area sizes and shorter durations, possibly 
consistent with what we see in Figure 35.  Lastly, the shape of the observed flood data 
and our envelope could indicate physical limits on storm size and contributing areas of 
flooding on larger basins in Colorado or a change in storm type altogether controlling 
flooding on larger basins, e.g. from rain-driven flooding to snowmelt.  This could suggest 
inaccuracies in flood frequency estimates as much as the peak flow envelopes.  In 
summary, peak flow envelopes are extremely useful, but should be used with judgment.      
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Figure 35: Regional 1/100 AEP (Q100) flood frequency estimates by USGS StreamStats (colored Xs) and by Bulletin 

17C (colored circles) at selected sites in the USGS Colorado Flood Database, overlaid on observed peak flows 
(black dots) and the peak flow envelope for our Mountain >7,500 feet elevation region. 

9.9 Upper Tail Ratios:  The Upper Tail Ratio (UTR) is a statistic defined by Smith et al (2018) as 
the ratio of maximum observed flood to the 10-YR ARI flood frequency estimate for a basin.  The 
UTR may serve as a good reasonableness check because it combines maximum observed flood 
data with a site-specific flood frequency estimate, thereby normalizing inter-basin variation in 
peak flows by a measure of respective site-specific flood frequency statistics.  The UTR metric 
may prove to have less variability than peak flows alone.   

Figure 35 above implies that UTR may decrease with larger area sizes.  In fact, cursory analysis 
by Colorado Dam Safety indicate as much (see Table 12, Figures 36 and 37).  Table 12 tabulates 
UTRs corresponding to envelope-controlling peak flows for our Mountains >7,500-ft elevation 
region peak flow envelope.  The Table 12 UTRs are plotted against drainage area size in Figure 36 
indicating decreasing UTR with area size.  The calculated UTRs at small areas are high compared 
to those reported by Smith et al (2018); however, Smith et al (2018) generally looked at larger 
gaged basins in the NWIS database.  Figure 36 also plots the UTR calculated for an example 
model design flood in comparison to the UTRs for observed floods, illustrating how UTRs may 
provide another reasonableness check of model results.  Smith et al (2018) found strong regional 
differences in UTRs (refer back to Figure 4 above), which may also be useful for model 
evaluation. Figure 37 shows 100-YR ARI upper tail ratios (i.e. USGS Colorado Flood Database peak 
flow divided by 100-YR ARI flood frequency estimate) at the same selected locations as the flood 
frequency estimates plotted in Figure 35.  Again there appears to be a drainage area dependence 
for the largest upper tail ratios.  
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Table 12:  Upper tail ratios for envelope-controlling peak flows in Colorado Dam Safety’s Mountain >7,500-ft elevation region 

 

 
Figure 36: Upper tail ratios (UTRs) for the Mountain region envelope-controlling peak flows in Table 12, along with an example 

modeled design flood UTR for comparison.  
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Figure  37:  Ratio of observed peak flows to 100-YR flood estimates at selected sites from the USGS Colorado Flood Database in 
our Mountains > 7,500-ft elevation region, the same sites for which flood frequency estimates are plotted in Figure 35.  
 

 
9.10 Previous Hydrology Studies:  Lastly in terms of reasonableness checks on CSU-SMA rainfall-
runoff model results, previous hydrology studies can be a good source of past hydroogical 
information, floods and analyses. Although their methods may be outdated, the results often 
provide a good point of comparison for explaining why current model results differ.  Previously 
study results should be concisely summarized for comparison. 

9.11 Confidence:  The reasonableness checks described above are firstly intended to 
evaluate rainfall-runoff model accuracy.  However, they should also be used to build 
confidence.  For risk-informed decision making, Colorado Dam Safety ranks confidence levels as 
Strong, Medium, or Poor (see Table 13 below).   The USBR (2004) and others have defined limits 
of credible flood frequency curve extrapolation in terms of the quality of available flood data 
(see Table 14 below).  Finally Nathan and Weinmann (2001) depict flood estimation procedures 
and uncertainties by AEP (see Figure 38). 

For Colorado Dam Safety hydrology study purposes, we propose that the following confidence 
levels should be used by the engineer/user to assess their results based on (1) REPS rainfall 
and CSU-SMA model confidence, (2) quality and amount of historical flood data that results from 
the above reasonableness checks, and (3) magnitude of storms/floods of interest:   

Strong confidence:  Confidence in REPS PMP storm transpositions and REPS AEP estimates; 
hydrologically similar basins to those CSU-SMA research used for calibration and verification.  
Stream gage data for basin-of-interest or transpositionable stream gate data from hydrologically 
similar basin(s) with longer periods of record, paleo-flood estimate(s), long (80-100 years) 
records of floods and hydrologic performance at an existing dam, and/or good regional data sets.  
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Table 13:  Example Confidence Levels from Colorado Dam Safety’s Guidelines for Comprehensive Dam Safety 
Evaluation (CDSE) Risk Assessments & Risk Informed Decision Making (RIDM), March 2021. 

 

 
Table 14: USBR recommended credible limits on flood frequency extrapolation (Swain et al, 2004) 

 
 

 

 
Figure 38:   Depiction of flood estimation procedures and uncertainty by AEP (from Nathan and 

Weinmann, 2001) 
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Good agreement is found between CSU-SMA modeled floods and multiple lines of site-specific 
historical flood evidence, e.g., flood frequency estimates, flood seasonality, controlling storm 
types, historical floods, etc. vs. rainfall-runoff model results.  Or differences between modeled 
floods and observed floods are within 90% confidence bounds (e.g. ASEp for USGS StreamStats, 
90% confidence bounds on Bulletin 17C flood frequency estimates, and conceptual 90% 
confidence bounds on peak flow envelopes) and the engineer can make a strong case for such 
differences on the basis of basin-specific hydro-meteorological characteristics.  Applies to floods 
of interest out to PMF for optimal data or to more frequent floods (e.g. 1/10,000 or 1/1000) with 
typical data.     

Medium confidence:  Confidence in REPS PMP storm transpositions and REPS AEP estimates; 
hydrologically similar basins to those CSU-SMA research used for calibration and verification.  
Good regional flood estimates are available (e.g. transpositioned/re-scaled Bulletin 17C flood 
frequency estimates, USGS StreamStats flood frequency estimates, and peak flow envelopes) 
within range of hydrologically similar data sets.  Good agreement is found between CSU-SMA 
modeled floods and multiple lines of regional flood evidence, e.g., flood seasonality, controlling 
storm types, historical floods, etc. vs. rainfall-runoff model results.  Differences between 
modeled floods and observed floods are within 90% confidence bounds on observed flood 
estimates; the engineer can partially, but not fully, explain such differences on the basis of 
basin-specific hydro-meteorological characteristics.  Data quality, model agreement or 
justification of differences needs to be commensurate with the magnitude of design flood of 
interest.  

Poor confidence:  Less confidence in REPS PMP storm transpositions and wider confidence bounds 
on REPS AEP estimates; less confidence in CSU-SMA rainfall-runoff model parameters.  Only 
regional flood estimates (e.g. USGS StreamStats, peak flow envelopes) are available for 
reasonableness checks and require extrapolation beyond range of observed floods.  Minimal lines 
of corroborating evidence are available in the observed flood record to support CSU-SMA model 
results.  Differences between modeled floods and observed floods (whether within 90% 
confidence bounds on regional flood estimates or not) cannot be explained convincingly based on 
basin-specific hydro-meteorological characteristics.      
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Section 10. CSU-SMA Model Parameter Calibration 

10.1 Traditionally extreme floods for dam safety in Colorado were estimated by extrapolation of 
uncalibrated rainfall-runoff models to extreme storms, often with unreasonably conservative 
results –- several orders of magnitude larger than observed floods in some cases.  In contrast, 
current agency thinking is that sufficient extreme flood data exists to allow model calibration in 
order to improve accuracy of model estimates.  The rational extension of the reasonableness 
checks described in the previous section is to adjust rainfall-runoff models to produce general 
agreement, to the extent possible, to the various checks -– flood frequency curves, controlling 
storm/flood type, historical flooding at dams, regional peak flow envelopes, etc.  Industry 
precedence exists for calibration of modeled flood-frequency estimates to observed flood-
frequency curves (Novembre and Wright, 2013; Schaefer et al, 2012; and Schaefer and Barker, 
2005).   

10.2 Combining the CSU-SMA model approach and reasonableness checks against he observed 
flood record offers the opportunity for use of two independent sources of flood information to 
improve dam safety hydrology estimates.  Each method has advantages, disadvantages, and its 
own sources of uncertainty, which will vary by basin.  The following CSU-SMA model calibration 
procedure is recommended, which considers both modeled and observed flood information, 
weights each according to the user’s confidence level (from Section 9.11), and allows the 
engineer to use their expertise to make the case for the final hydrology results4.  See 
Appendix C for a Model Parameter Calibration Checklist/template.  

1) Determine the most likely controlling storm type for the basin based on comparison of 
initial CSU-SMA model results versus basin area size (see Section 9.6 and Table 10), type of 
historical storms/floods (Sections 9.4 and 9.8), and seasonality of historical/observed 
floods (Section 9.7, Figures 23-25). If there is no clear controlling storm type for a basin-of-
interest, then calibrate all modeled storm types.  

2) Calibrate CSU-SMA model parameters to obtain reasonable agreement between the REPS 
10e-2 AEP controlling storm-type peak flow and the 1/100 AEP flood frequency estimate 
from the observed flood record (e.g. by Bulletin 17C, transpositioned Bulletin 17C 
estimate, USGS StreamStats, etc.), based on the assumption of AEP neutrality (i.e., a given 
AEP storm yields the same AEP flood peak).  For purposes of these guidelines, closer 
agreement between modeled peak flow and the flood frequency estimate is better, but in 
all cases, model results should be within 90% confidence bounds on flood frequency 
estimates.  Remaining differences after calibration should be explained by the engineer.  
Recommendations are provided below in terms of which model parameters should be 
adjusted based on controlling storm type and controlling flood production mechanism.  
NOTE: Modeled flood volume calibration is recommended for basins and dams where long 
duration storms/floods (e.g. 48hr MLC, 72hr General Storm PMF) are controlling, and 
therefore flood volume and hydrograph shape are important for reservoir routing and 
spillway sizing.  In practice, flood volume calibration may only be possible for gaged basins 
or existing dams with good reservoir storage data, such that daily flood-volume frequency 
analysis can be performed.    

3) Similar checks between modeled peak flows and flood frequency estimates and further 
calibration, if needed, should be made at 2x10e-3 and 10e-3 AEPs.  Consideration should be 
given to calibrating to paleo-flood peak flow estimates, if available for the basin-of-
interest or re-scaled from hydrologically similar basins, using the estimated paleo-age.   

                                                 
4 Model calibration should be performed prior to applying Dam Safety Rule 7.2.4, Atmospheric Moisture Factor 
(1.07), to Inflow Design Floods.  See the next page for more details.  

https://drive.google.com/drive/folders/1EfH1hkcY41VxTZk0QFJfIPcadkQ-61Sm?usp=sharing
https://drive.google.com/drive/folders/1EfH1hkcY41VxTZk0QFJfIPcadkQ-61Sm?usp=sharing
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4) Other site-specific reasonableness checks from Section 9 should be used to inform the 
model calibration.  For example, model parameters should be adjusted to produce general 
agreement with reservoir record pool, record inflows or record dam overtopping over the 
lifetime of an existing dam, historical frequency of spillway activation, historical large 
floods, historical storm types and seasonality of flooding, etc.  

 
5) Lastly, run REPS PMP (all applicable storm types) in the calibrated CSU-SMA model, and the 

controlling modeled PMF peak flow should be checked against Colorado Dam Safety’s 
regional peak flow envelopes.  For the purposes of these guidelines, closer agreement 
between modeled PMF peak flow and its respective regional envelope is better, but in all 
cases the modeled PMF peak flow should lie within the conceptual 0.3log10 cycle - 90% 
confidence bounds on the envelopes.  Model calibration should then be completed using 
a weighted-average of modeled and envelope peak flows per Table 15 below, according 
to the user’s confidence level (see Section 9.11).  This weighting can be viewed as an 
empirical Bayesian approach after Kuczera (1982) that gives greater weight to the CSU-
SMA model (and site-specific calibration in steps 1-4 above) when confidence in them is 
strong, but greater weight to the regional flood information in the envelope curves 
when confidence in the basin model is poor. 

 
Table 15: Weights for modeled REPS PMF peak flow and regional envelope peak flow, based on confidence level, for final 
CSU-SMA model calibration to weighted average PMF. 

Confidence Level 
(see Section 9.11) 

Weight applied to 
CSU-SMA model 
controlling REPS 
PMF peak flow 

Weight applied to 
regional envelope 

peak flow Comments 

Strong 1.0 0 

CSU-SMA model (after site-specific calibration steps 
1-4 above) used without further calibration to 
regional envelope peak flow.  Model PMF peak flow 
must lie within envelope 90% confidence bounds, 
and engineer can make a strong case for such 
differences on the basis of basin-specific hydro-
meteorological characteristics.  

Medium 0.5 0.5 

CSU-SMA model (after site-specific calibration steps 
1-4 above) PMF peak flow weighted equally with 
regional envelope peak flow;  Final calibration of 
CSU-SMA model PMF should be made to match the 
resulting weighted average PMF peak flow.  

Poor 0 1.0 

CSU-SMA model (after site-specific calibration steps 
1-4) PMF peak flow is not reliable due to poor 
confidence in reasonableness checks and lack of 
site-specific information.  Final calibration of CSU-
SMA model PMF should be made to match the 
regional envelope peak flow.  

 
     

 The following additional considerations are offered for model calibration:  

• Where a basin spans multiple peak flow envelope regions, then an area-weighted average 
envelope peak flow may be used or use partial area analysis in the controlling region. 

• Particularly for the Front Range & Eastern Plains region, large differences in the observed 
flood record between regional envelope peak flows and more frequent 1/100 and 1/1000 
AEP floods suggest possible non-linear runoff response to extreme rainfall.  If the CSU-SMA 
rainfall-runoff model cannot be calibrated to work at both upper and lower ends (i.e. PMF 
to the peak flow envelope and 100-YR to flood frequency curve), then consideration should 
be given to using non-linear runoff transformation, for example, by HEC-HMS’s Variable 
Clark UH method or using HEC-RAS 2D. In HMS’s Clark Variable method, Tc and R 
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parameters can be decreased for increasing excess precipitation to allow calibration of the 
100-YR flood, PMF to the peak flow envelope, and other intermediate points (ex. 1000-YR 
flood, paleo-flood, etc.). These calibration points can be used to define a percentage curve 
table of %Tc and %R versus %excess precipitation (relative to an index value).  Also for the 
Mountain Region (>7,500 ft elev.), non-linear runoff transformation may be indicated at 
small area sizes (<5 sq mi); however, the user should consider caveats regarding possible 
influence of debris flows as discussed in Section 9.8 above.   

• Calibration to regional peak flow envelopes may not capture basin-specific differences.  
Our experience is that the regional differences that are captured by the regional envelope 
curves far out-weigh basin-specific differences (when compared to historical hydrology 
studies that ignored regional differences).   

• Notional AEP of PMP and PMF can be determined by comparing REPS PMP results against 
REPS precipitation frequency (see Sections 4 and 8 above).  This cross-check is a strength 
of REPS.  Where notional AEP of REPS PMP/PMF is far less than 10e-7 AEP, then the 
modeled PMF may plot far above the regional peak flow envelopes.  In such cases the State 
Engineer may grant a waiver to State Dam Safety Rule 7.2, allowing an acceptable risk-
based probabilistic IDF criteria less than deterministic PMP.   

• Climate change has the potential to increase flood yields in Colorado in the future (REPS 
Summary Report, Vol. VI).  Based on the recommendations by NOAA and others, Colorado 
Dam Safety implemented Dam Safety Rule 7.2.4, Atmospheric Moisture Factor (AMF), which 
requires that rainfall estimates for determining inflow design floods shall be multiplied by 
1.07 to account for expected increases in temperature and moisture-holding capacity of 
the atmosphere over the next 50 years.  This factor must be applied to IDFs for new dams, 
enlargements, and spillway design projects to account for expected design life; it should 
be applied after hydrology model calibration.  Generally, the AMF should not be applied for 
hydrologic risk studies and evaluation of the safety of existing dams, because risk-analysis 
reflects current conditions.        

• Where observed peak flows and historical flooding are dominated by snowmelt, which is 
true for many basins above 7,500 feet elevation in Colorado, then rainfall flood frequency 
estimates are necessarily lower, at least within the period of record.  However, the general 
assumption is that rainfall flooding will exceed snowmelt flooding at some extreme AEP 
(i.e. steeper flood frequency curve), although Jarrett and Tomlinson (2000) said this 
assumption is not supported by paleo-flood data out to 10,000 years based on their study in 
northwest Colorado.  Nevertheless, the conservative and recommended approach here is to 
calibrate the controlling REPS storm type to the snowmelt-based 100-YR flood frequency 
estimate, per the calibration procedure described above, unless paleo-flood or other 
evidence suggests some other AEP.  This approach is considered to be conservative, but 
still reasonably supported by the magnitude of historical flooding.  Alternatively, a 
baseflow may be used in HEC-HMS to make up the difference between the modeled REPS 
and flood frequency 100-YR floods, assuming this difference is due to snowmelt.  

• As discussed in Section 9, advanced studies may perform historical flood event calibration 
using reconstructed rainfall and stream gage flood hydrographs, reservoir stage records, 
etc.  If possible, independent verification should be done on multiple historical 
storms/floods.  This approach is only expected for large, complex projects and as 
warranted by dam size or hazard potential.     

10.3 This section provides information on specific CSU-SMA model parameters for 
calibration. Select parameters can be adjusted based on controlling storm type and controlling 
runoff mechanisms in order to better match historical flooding:  
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• Impervious (%): The percentage of sub-basin area that will not infiltrate/store any 
precipitation. These areas will always produce surface runoff.  Increasing impervious area 
will tend to produce larger surface runoff, particularly from high-intensity rainfall.   

• Soil % (Initial soil moisture): The percentage of soil storage occupied by water at the 
beginning of the storm. Special care should be applied when setting this value. If the initial 
soil moisture is set higher than tension storage, the model will start in a phase of discharge 
from subsurface stormflow and may overestimate the rising limb of the hydrograph.  High 
initial soil moisture may also lead to saturation-excess runoff.   

• Maximum Infiltration Rate (in/hr): Maximum rate at which water can enter soil storage. 
The actual infiltration rate varies as a function of available soil storage. Higher available 
soil storage translates to an infiltration rate closer to the specified maximum.  Increasing 
maximum infiltration rate will tend to produce less infiltration-excess runoff.   

• Soil Storage (inches): This value represents the maximum amount of water that can be 
stored in the soil layer and directly affects infiltration rate (see above). Lower soil storage 
may lead to soil saturation and saturation-excess runoff.   

• Tension Storage (inches): This value is the portion of soil storage that must be overcome 
before water can leave the soil layer and enter the groundwater layer via soil percolation. 
Higher tension storage values can restrict/delay subsurface stormflow.  Mainly applicable 
where long-duration General Storms control the design flood; decreasing tension storage 
will increase sub-surface flow associated with low intensity rainfall.   

• Max Soil Percolation Rate (in/hr): Maximum rate at which water leaves the soil layer and 
enters the groundwater layer. Like max infiltration, this rate is a function of soil storage. 
This rate only comes into play once tension storage is overcome. Constricting this value can 
force saturation-excess runoff to occur. If this parameter is higher, the model will produce 
more subsurface stormflow instead of saturation-excess runoff.  

• GW % (GW saturation): defines the percentage of groundwater storage occupied by water 
at the beginning of the storm. The CSU-SMA method assumes this value is zero since flow 
before the rising limb of the observed hydrographs remains nearly constant. Starting a 
simulation with water in the GW layer is similar to when initial soil moisture is above the 
tension storage threshold and the soil percolation rate is high (i.e. may cause 
overestimation of early storm flows by subsurface stormflow).   

• GW Storage (inches): Represents the maximum amount of water that can be stored in the 
GW layer. Large values for this parameter result in models that emphasize the subsurface 
component of the hydrograph. Reducing this value can force saturation excess runoff for 
long duration storms. However, using small values for this parameter means that 
groundwater layer is usually saturated. This creates a near-constant discharge from this 
layer that is not as sensitive to changes in precipitation. Woolridge (2019) showed that 
using small values for GW storage can accurately simulate subsurface stormflow dominant 
hydrographs (i.e. Bear Creek, Sept. 2013 flood).  

• GW Time Coefficient (hr): This parameter controls the rate at which water is released 
from the groundwater layer. Shorter time constants lead to increased subsurface stormflow 
with similar timing as surface runoff. Models using shorter time constants are also more 
sensitive to changes in precipitation. Models using longer time constants result in more 
attenuated hydrographs that are not as sensitive to changes in precipitation. Where 
subsurface flood flows are significant, calibration of this parameter may be necessary in 
order to make subsurface and surface peaks coincide, i.e., to avoid a double peak 
hydrograph.  

• GW Percolation Rate (in/hr): This parameter determines net loss to the system and can 
help with adjusting flood volume. For the CSU-SMA method it was determined through 
calibration to historical floods in both the Front Range and San Juans. The value in the 
Front Range basins (2 – 3 mm/hr) is higher than that in the San Juans (0.5 – 1 mm/hr). 
Changing this value can have large effects on peak flows and volume.  

• Linear Reservoir Coefficient (hr): This parameter controls the rate at which water that 
has left the groundwater layer is routed to the stream. Effects of changing this parameter 
are similar to those listed in the “GW Time Coefficient” description.  
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• Clark Unit Hydrograph Time of Concentration (hr):  Tc generally represents channel 
storage and travel time through the basin stream network.  Decreasing Tc will produce 
larger peak flows and flashier surface runoff hydrographs.  See discussions above about use 
of Clark Variable method to produce non-linear runoff response, i.e., flashier runoff 
response with increasing rainfall intensity and excess precipitation.   

• Clark Unit Hydrograph Storage Coefficient (hr):   R generally represents hillslope storage 
in the basin.  Decreasing R will have a similar effect as decreasing Tc, producing larger 
peak flows and flashier surface runoff hydrographs. 

10.4 The following additional guidance is provided on parameter calibrations for emphasizing 
different runoff production mechanisms: 
 
• For Infiltration-Excess Runoff:  

o Max infiltration rate: Reduction of infiltration rate will force more excess precipitation 
leading to higher peak flows and volumes of infiltration-excess runoff by intense REPS 
Local Storms.  

o Impervious Area: Increasing the impervious area can result in higher runoff peak flows 
and volumes and overall quicker response runoff.  

• For Saturation-Excess Runoff: 
o Reduce soil storage, increase tension storage to a value closer to soil storage, and 

reduce soil percolation rate: Less soil storage for water to fill up will cause 
saturation-excess runoff to occur. Increasing the tension storage capacity would allow 
water (both pre-event and event) to remain in the soil layer longer without draining to 
the groundwater layer. Reducing the rate water is transferred from the soil layer to the 
groundwater layer leads to the soil layer filling up earlier.  

o Increase GW time coefficient: This method is not as direct as the preceding ones, but 
creates a back-up of groundwater into soil storage. Longer time constants translate to 
a slower subsurface flow response. However, slowing the groundwater flow can lead to 
dissimilar timing with surface runoff and create an unrealistic double-peak effect in 
the output hydrograph.  

• Subsurface Stormflow: 
o Increase GW storage: Since subsurface stormflow is modeled as a linear reservoir, 

increasing the storage will increase the magnitude of outflow. If there is a combination 
of high subsurface flow and surface runoff, this adjustment may cause an unrealistic 
double-peak effect due to the differences in timing of the two flow components. This 
usually takes the form of an early spike in the hydrograph from saturation-excess 
runoff, followed by large volumes of subsurface flow.  

o Reduce GW time coefficient: Reducing the time coefficient speeds up the rate water 
is released from the groundwater layer. If reduced enough, resulting subsurface 
stormflow hydrographs could look like surface runoff hydrographs.  

o Reduce GW percolation rate: By reducing system loss, more water is available from 
the storm to translate to streamflow. This parameter can change runoff mechanisms 
and flow volumes drastically in some cases.
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	Section 1. Introduction
	This document provides Colorado Dam Safety guidelines for hydrological modeling and flood analysis for design and risk analysis of hydrologic features of dams.  Guidelines represent the agency’s current thinking and are recommended for use on projects...
	These guidelines describe a new and different hydrological modeling process that incorporates site-specific and regional observed flood information.  We still greatly rely on rainfall estimates and rainfall-runoff modeling to simulate flood timing, du...
	Caveats:
	1. Before starting a new hydrology study, please see our Overview of Hydrologic Evaluation and Design Processes document for a high-level roadmap of our two distinct hydrology processes: (1) risk-informed hydrologic evaluation for existing dams and (2...
	2. Please also see the following related Colorado Dam Safety guidelines:
	 For extreme rainfall estimation using Colorado’s Regional Extreme Precipitation Study (REPS) tools, please see Guidelines for the Use of Regional Extreme Precipitation Study (REPS) Rainfall Estimation Tools
	 For analysis and estimation of consequences from hydrologic dam failure (used for hydrologic risk analysis and to determine risk-based Inflow Design Flood criteria), please see Guidelines for Hydrologic Hazard Analysis.

	3. Previous Colorado Dam Safety Hydrologic Basin Response and Parameter Estimation Guidelines (2008) are superseded by these current hydrological modeling guidelines.

	Section 2. Background
	Previous Colorado Dam Safety hydrology guidelines (2008) recommended the Green & Ampt method to model infiltration losses.  Because Green & Ampt is an infinite sink (i.e., losses are unlimited), maximum infiltration rates (Ksat) were artificially capp...
	Flood Hydrology Manual (Cudworth, 1989) hydrology methods have been popular for dam safety purposes for many years.  But at the time of its publication Cudworth acknowledged “data representing basins located at higher elevations of these [Rocky Mounta...
	In 2017, as part of a site-specific hydrology study for a dam enlargement project, Colorado Dam Safety developed a proof-of-concept hydrology model (“Mountain Hydrology Model”) that used higher infiltration rates (i.e., without artificial caps) and an...
	Following the 2017 proof-of-concept study, Colorado Dam Safety began a multi-year Mountain Hydrology Research Study with Colorado State University to develop new hydrology methods that accurately reproduce extreme flood production mechanisms in Colora...
	During the course of the CSU Phase I study, Colorado Dam Safety completed the Regional Extreme Precipitation Study (REPS), which provides updated extreme precipitation frequency and probable maximum precipitation estimates for Colorado.  REPS found th...
	In Phase II of the Mountain Hydrology Research Study, CSU developed parameter estimation methods for HEC-HMS SMA and then verified these methods for three basins and six historical floods in the San Juan Mountains (Irvin et al, 2021).   CSU’s research...
	Finally, a large amount of historical extreme and extraordinary flood information exists for Colorado and forms the basis of reasonableness checks and model calibration discussed later in Sections 9 and 10 of these guidelines.  In brief, two simple fi...

	Section 3.  Overview of CSU-SMA Hydrology Modeling Method
	3.1 The previous section explained limitations of traditional dam safety flood hydrology modeling approaches and introduced the new Colorado State University-Soil Moisture Accounting (CSU-SMA) approach that can simulate infiltration-excess, saturation...
	3.2 This section provides an overview of the CSU-SMA model. It was developed using HEC-HMS 4.7; however, because computer programs change frequently, the discussion here is intended to allow adaptation to future versions of HEC-HMS or other hydrology ...
	As soil water storage increases towards saturation, infiltration capacity decreases from its maximum, at zero soil storage, to zero infiltration, at soil saturation.  This is a key difference from previous Green & Ampt and Initial and Constant Loss me...
	3.3 Other models, both existing and future, may be able to adequately represent the necessary flood production mechanisms.  These may include GSSHA, MIKE SHE, SEFM and others.   A layered Green & Ampt approach with soil moisture accounting may accurat...
	3.4 The CSU-SMA model uses the Clark UH method in HEC-HMS for rainfall-runoff transformation.  The Clark UH is well documented in hydrology literature and is widely used in practice.  Our experience (and CSU research) suggests that the unit hydrograph...
	3.5 The CSU-SMA model uses the Linear Reservoir baseflow method.
	3.6 The CSU-SMA loss method in combination with the Clark UH is a conceptual approach that can produce a wide range of streamflow responses seen in the diverse terrain across Colorado.  Later in these guidelines we suggest that flashy unit hydrograph ...
	3.7 Snowmelt and rain-on-snow runoff are not explicitly addressed in the CSU-SMA modeling method.  Clearly snowmelt is an important runoff production mechanism for mountain basins in Colorado.  Typically, annual peak flows for basins above about 7,500...
	Figure  7: Overview of data  sources, processing, and model parameters for the CSU-SMA modeling method (from Irvin et al, 2021, with permission).
	Figure 7 gives an overview of the data, processing, and model parameters that are needed for the CSU-SMA modeling method.  The following Sections 4, 5, and 6 provide details on each step.
	3.8 Limitations:  The CSU-SMA modeling method described below requires user expertise and judgment.  Sections 4-8 provide prescriptive steps, which should be considered as a starting point. Sections 9 and 10 describe checks, confidence, and calibratio...
	Key references used in these guidelines are available at the following DWR ftp link for easy access and transparency so that the user is fully informed of the methods described herein (also see References section at the end of these guidelines):
	https://drive.google.com/drive/folders/1bJBtYHy96ejo1YdS5xosaJi2TsVKto20?usp=sharing
	The CSU-SMA method has been tested over a variety of basins across Colorado; however, situations requiring engineering judgment are sure to arise, at the responsibility of the user.  Likewise, the computer tools provided herein are provided in good fa...
	Lastly, these guidelines do not address burn scar hydrology associated with wildfires or their increasing occurrence in Colorado.  Further research is needed on the effects of burn scar hydrology on extreme floods in Colorado and on joint probabilitie...

	Section 4.  CSU-SMA Method Input Data
	4.1 This section describes input data sets needed for the CSU-SMA method using HEC-HMS 4.7 and ArcMap 10.4.1 with Spatial Analyst Extension.  Data sources may change and are the responsibility of the user.  Tip: the CSU-SMA method involves a large amo...
	4.2 Drainage basin boundary and point of concentration GIS shapefiles:  These can easily be generated for the basin-of-interest using USGS StreamStats at https://streamstats.usgs.gov/ss/
	4.3 DEM Terrain data:  DEM data is needed for input to HEC-HMS for delineation of sub-basins and for determining certain basin properties used for unit hydrograph transformation and reach routing.   DEM data can be downloaded from the USGS, currently ...
	In general, 10 meter (1/3 arc second) DEM grid resolution is considered to be adequate for hydrologic analysis; however, higher resolution DEM data, where available, may be useful for small or complex basins*.  DEM data must be in GeoTiff format. The ...
	* LiDAR DEM data for most of Colorado is available from the CWCB Colorado Hazard Mapping & Risk MAP Portal at the following weblink:  https://coloradohazardmapping.com/lidarDownload
	4.4 Landsat red and infrared band images0F :  These data sets are needed to calculate fractional vegetative cover (Fg) for the basin.  Landsat images can be downloaded from the following website:  https://earthexplorer.usgs.gov/
	The following instructions are suggested for the current version of the Earth Explorer website: (1) create a login (user must be logged-in to download data), (2) Set Search Criteria -> Use map and zoom to area of interest, (3) Select Data Sets -> Land...
	4.5 Soil property raster data sets:  Raster data sets of percent sand, percent clay, percent organic matter, and of depth to restrictive layer were obtained from the NRCS Gridded National Soil Survey Geographic Database (gNATSGO).  These raster data s...
	4.6 Design Storms, Temporal Data:  Colorado Regional Extreme Precipitation Study (REPS) PMP and precipitation frequency tools should be used for design storm inputs.  See Colorado Dam Safety’s Guidelines for the Use of Regional Extreme Precipitation S...
	Where a drainage basin size exceeds storm area size limits in REPS, then partial area analysis should be performed.  REPS area size limits by storm type are shown below in Table 3.
	Table 3:  REPS PMP Tool and MetPortal Precipitation Frequency tool storm area size limits by storm type
	* REPS Metportal macro region for basin-of-interest is reported on the Watershed PF tab of MetPortal; also, the Macro Region layer can be turned on in the MetPortal map display.
	In general, partial area analysis should use the maximum storm area size allowed by REPS, with the storm area positioned closest to the dam or basin outlet.  Individual cases may vary in terms of determining controlling runoff.
	Tip: In practice, HEC-HMS modeling will be easier if sub-basins are delineated first (see Section 5 below), and then REPS partial areas, if needed, are selected to consist of discrete HEC-HMS sub-basins, as close in size to the REPS storm area size li...
	Where the basin-of-interest is smaller than REPS storm area size limits, then simply run the REPS PMP and MetPortal precipitation frequency tools for the entire basin area.  We recommend using spatially uniform REPS design storms for most basins.  Opt...


	Section 5.  Generating CSU-SMA Model Sub-basin Properties
	5.1 Some minor pre-processing of the input data is necessary in order to generate sub-basin properties in ArcMap and in HEC-HMS, which are in turn used to generate CSU-SMA model parameters.
	5.1.1 Calculate a fractional vegetative cover (Fg) raster from Landsat images (directions are based on ArcMap 10.4.1)1F :
	5.1.2 Next in terms of pre-processing input data to determine sub-basin properties: first mosaic DEMs if multiple DEMs are needed to cover basin-of-interest, (see ArcMap mosaic instructions in Section 5.1.1), then clip the DEM in ArcMap to the general...
	 To buffer basin shapefile:  Use ArcToolbox Analysis Tools->Proximity->Buffer
	 To clip the DEM tif:
	o Data management Tools -> Raster ->Raster Processing->Clip (keep output in tif format for use in HEC-HMS)
	o Check the box: Use input features for clipping geometry
	o Specify “.tif” extension in output raster filename

	5.2 For determining sub-basin properties, delineate sub-basins in HEC-HMS using the clipped DEM, then calculate sub-basin characteristics and reach characteristics in HEC-HMS2F :
	 Open HEC-HMS, create a new project and save.   Select U.S. Customary units.  NOTE: DEM units (typically meters) are specified when the terrain model is imported (see below).
	 Create a basin model: Components >> Basin Model Manager
	 Create a terrain model: Components >> Terrain Model Manager
	 Name new Terrain
	 Navigate to your clipped DEM tif file (see above).  Specify elevation units (typically meters)
	 For Sub-basin Delineation:  In the watershed explorer, select the basin model and link Terrain Data to the new Terrain model, then follow the prompts:
	o Select UTM predefined coordinates (Zone 13N for most of CO, except Zone 12N for the far west) (GIS drop down menu, select coordinate system – predefined).  Tip: At this point user may need to link the basin model to the terrain model again for the D...
	o Next, GIS menu -> select “Process Sinks” – HMS will then identify and fill in any drainage pits in the DEM (NOTE: engineer should use judgement to determine whether this step is appropriate for the basin-of-interest)
	o GIS menu -> select “Process Drainage” – this step combines the creation of flow direction and flow accumulation grids.
	o GIS menu -> select “Identify Streams” – this will create a stream network based on a user-specified area threshold*
	*Guidance on Area Threshold:  Area threshold in HEC-HMS defines the minimum contributing area where streams start.  Area threshold is related to, but not equal to sub-basin area size. Under “Delineate Elements” (see below) HEC-HMS will create sub-basi...
	o Next, right click anywhere in the basin model window and select “Map Layers” -> Add -> USGS StreamStats point of concentration shapefile (i.e. globalwatershedpoint.shp) to define the basin outlet
	o Turn off all map layers except the USGS StreamStats POC and the Identified Streams layer
	o Zoom in to the POC
	o Use Break Point Creation Tool (cross with red dot) -> select point on stream closest to USGS StreamStats POC to define the basin outlet (Tip: break point must be directly on an identified stream)
	o Repeat Break Point Creation Tool to create break points at specific sub-basin locations*, if desired; otherwise, HEC-HMS will automatically delineate sub-basins based on junctions in its identified stream network.
	*Guidance on Sub-basins (cross-reference Guidance on Area Threshold, above).
	The following factors should be considered in determining sub-basin area sizes and locations:
	1) REPS Climate Regions: Sub-basins should be used where REPS PMP estimates vary significantly across climate regions, for example, if the basin spans across REPS climate (storm transposition) zone 3 (foothills) and zone 5 (mountains).  In this case, ...
	2) REPS Storm Area Size Limits (see Section 4.6 above):  If the basin-of-interest exceeds REPS storm area size limits, then partial area sub-basins should be used for REPS analysis of relevant storm types.
	3) CSU Contributing Area Threshold (see Guidelines on Area Threshold above):  HEC-HMS area threshold per the above guidance will determine the density of HEC-HMS’s stream network and sub-basins at junctions, by default. However, if breakpoints are ent...
	4) Physiographic differences:  Sub-basins should used to separate significant differences in basin soils, vegetative cover, slope, etc., which would result in different unit hydrograph responses and infiltration losses.
	5) Key locations for model reasonableness checks and model calibration: e.g. stream gage locations, locations of paleoflood estimates, indirect flood peaks, etc.
	o Next, use GIS menu and select “Delineate Elements”
	o Set subbasin prefix to “Sub-“, set reach prefix to “Reach-“, “Yes” for insert junctions, set junction prefix to “Junction-“, and “Yes” for convert breakpoints
	o Click OK and HMS will delineate the watershed of interest and create sub-basins and stream reach structure
	o Export the sub-basin structure as a shapefile: GIS menu -> “Export Georeferenced Elements”
	o In ArcMap create a raster version of the sub-basin shapefile using ArcToolbox->Conversion Tools->To Raster->Polygon to raster. Both the polygon and the raster versions will be needed to estimate parameters in Section 6 below.
	o The user needs to check the HMS basin delineation for accuracy.  Tip: If necessary, the user can manually edit the subbasins shapefile in ArcMap.  Then re-open HEC-HMS and delete only the edited sub-basin elements and re-import the edited sub-basin ...
	 For Clark Unit Hydrograph:
	o HEC-HMS Parameters menu -> Subbasin Area. Lists area size of each subbasin.
	o HEC-HMS Parameters menu -> Characteristics -> Sub-basin. HMS will calculate sub-basin properties to be used in unit hydrograph parameter calculations (Clark UH parameter calculations are described in Section 6 below).
	o The following relevant sub-basin properties are calculated by HEC-HMS:  area, longest flow path length, longest flowpath slope, and centroidal flowpath length.
	5.3 The final step in Generating Sub-basin Properties is to calculate sub-basin average soil and vegetation properties: %sand, %clay, %organic matter, depth to restrictive layer, and fractional vegetation cover.  These sub-basin properties can be calc...
	 Sbprop_sand_table: sub-basin average sand fraction, use Mean column [unitless]
	 Sbprop_clay_table: sub-basin average clay fraction, use Mean column [unitless]
	 Sbprop_om_table: sub-basin average organic matter fraction, use Mean column [unitless]
	 Sbprop_dtrl_table, sub-basin average depth-to-restrictive-layer, use Mean column [inches]
	 Sbprop_fg_table, sub-basin average fractional vegetation cover (described above), use Mean column [unitless]
	As described in the following section the CSU-SMApython script will use these soil and vegetative cover properties to calculate HEC-HMS SMA soil loss parameters with pedotransfer functions by Saxton & Rawls (2006).
	NOTE: The gNATSCO data set has a small fraction of missing data over Colorado, but is considered best available information.  The CSU-SMApython script simply ignores missing data when calculating sub-basin average properties and model parameters.  We ...
	5.4 Sub-basin Properties Reporting Requirements:  Engineers should provide the following reporting and quality control checks for sub-basin properties (NOTE: see hyperlinks below to supporting spreadsheet tools, provided as a courtesy and at the user’...
	5.4.1 REPS PMP Tool Output Reporting (see examples in Appendix A):
	 Print GIS map of cumulative rainfall for each PMP storm type applicable to the basin of interest (e.g. 2hr LS PMP, 6hr LS PMP, 24hr LS PMP (Zones 1 and 3 only), 72hr GS PMP, and 72hr TS PMP (south of 38.5º lat. only))
	 Print basin average PMP GIS attribute table output for each storm type.
	 Print temporal distribution data and graph the cumulative rainfall hyetographs for each storm type (link to spreadsheet tool).  For each storm type, only include the temporal distribution(s) used in the analysis (e.g. LS 6hr Synthetic West; see REPS...
	 For each storm type, print PMP_points GIS attribute table output (e.g. Local_PMP_Points_basinname_XXsqmi), which shows controlling historical storms by duration and location at each grid cell in the basin-of-interest.
	5.4.2 REPS MetPortal Precipitation Frequency Output:
	 Print screen image of Frequency Curve with confidence bounds and REPS PMP for the same duration, along with the map image of the basin shapefile, for each storm type.
	5.4.3 If Partial Area Analysis is performed based on REPS storm area size limits (see Section 4.6 above), include a summary table that shows which sub-basins are included and area size for each partial area by REPS storm type (link to sample spreadshe...
	5.4.4 Document and report the selected NDVIo and NDVIinf values for basin-of interest that were used to calculate fractional vegetative cover (Fg).
	5.4.5 Print the five CSU-SMApython sub-basin property output tables listed above in Section 5.3 (Sbprop_sand_table, Sbprop_clay_table, Sbprop_om_table, Sbprop_dtrl_table, and Sbprop_fg_table).
	5.4.6 Create a sub-basin properties summary table for reporting and review purposes to include the following properties by sub-basin: average %sand, average %clay, average %OM, average Depth to Restrictive Layer in inches, and average % fractional veg...
	5.4.7 Create a stream reach properties table for reporting and review purposes to include the following: reach length in feet, reach slope in ft/ft, and stream cross-section geometry description (Link to sample spreadsheet tool).
	5.4.8 Print GIS maps of the following sub-basin properties (see examples in Appendix A):
	5.4.9 For QC checking, sub-basin maps and sub-basin property averages should be reviewed to determine whether they make physical sense for the basin and region of interest.


	Section 6.  CSU-SMA Model Parameter Estimates
	6.1 The CSU-SMA method uses the following elements & methods in HEC-HMS, for which parameter estimates are necessary (cross-reference Figure 5 above):
	 Meteorological Model: Precipitation Specified Hyetograph, Annual Evapotranspiration
	 Basin Model: Simple Canopy, Soil Moisture Acccounting (SMA) loss, Clark Unit Hydrograph transform, Linear Reservoir baseflow
	 Reach Routing: Muskinghum-Cunge
	6.2 HEC-HMS SMA model loss method parameters can be estimated based on the CSU Mountain Hydrology Research Study Phase II (Irvin, 2021).  Irvin (2021) developed soil hydraulic properties after Rawls et al (1983), Saxton and Rawls (2006), and Sabol (20...
	Please note the following points about the CSU-SMApython2 ArcTool and python script:
	 The CSU_SMApython2.tbx file, Loss folder, and all files in the folder must be downloaded
	 We recommend saving the files/folder to a local hard drive to run in ArcMap
	 The full script is shown in Appendix B, for transparency.  The downloaded script can be edited as-needed using IDLE, with the understanding that Colorado Dam Safety will review projects based on our version and significant changes should be document...
	 Irvin (2021), Rawls et al (1983), Saxton and Rawls (2006), and Sabol (2008) papers are provided at the following Google Drive link, for easy reference and transparency: https://drive.google.com/drive/folders/1bJBtYHy96ejo1YdS5xosaJi2TsVKto20?usp=sha...
	To run the CSU_SMApython2 tool in ArcMap, select “Add Toolbox” in the ArcToolbox window and navigate to the downloaded CSU_SMApython2.tbx file.  In the new toolbox, right click on CSU_SMApython, select properties, and navigate to the location of the d...
	Using the dropdowns, select the %sand, %clay, % organic matter (OM), depth to restrictive layer input data (all from Section 4.5 above), and Fg fractional vegetative cover raster (from Section 5.1 above).  Navigate to the HEC-HMS Sub-basin shapefile a...
	First the CSU_SMApython script calculates the following soil hydraulic properties using pedotransfer functions from Rawls et al (1983), Saxton and Rawls (2006), and Sabol (2008):
	 Soil water fraction at saturation (theta_s)
	 Soil water fraction at field capacity (theta_33)
	 Soil water fraction at wilting point (theta_1500)
	 Wetting front suction head (psif)
	 Saturated hydraulic conductivity for bare ground in mm/hr (Ksatbare)
	 Saturated hydraulic conductivity adjusted for vegetative cover in mm/hr (Ksat)
	 Max infiltration rate over 3-inch depth using Green & Ampt equation (f)
	 Maximum soil water storage, inches, (S_max)
	 Field capacity water storage, inches, (Si_fld)
	 Wilting point water storage, inches, (Si_wp)
	Next the CSU_SMApython script uses the above soil hydraulic properties to estimate the following HEC-HMS SMA loss method parameters. Equations for parameters are shown in Table 4.
	 Max infiltration, in/hr (HMS_maxinfil)
	 Soil percolation, in/hr (HMS_soilperc)
	 Soil storage, inches (HMS_ss)
	 GW1 storage, inches (HMS_GWst)
	 Tension storage, inches (HMS_tens)
	 Initial soil moisture, Soil, % (HMS_InSM)
	Table 4: CSU-SMA parameter equations
	The CSU_SMApython script creates output tables for sub-basin average soil properties (listed in Section 5.3 above), and it creates the following output tables for HEC-HMS SMA loss method parameter estimates:
	 hms_maxinfil_table [units=in/hr] == HEC-HMS Max Infiltration (in/hr)
	 hms_soilperc_table [units=in/hr] == HEC-HMS Soil Percolation (in/hr)
	 hms_soilstorage_table [units=inches] == HEC-HMS Soil Storage (in)
	 hms_gw1storage_table [units=inches] == HEC-HMS parameter GW1 Storage (in)
	 hms_tensionstore_table [units=inches] == HEC-HMS Tension Storage (in)
	 hms_initialsm_table [units=%] == HEC-HMS Soil (%)
	Navigate to the user-specified CSU_SMApython output folder and load the soil property and SMA parameter output tables into ArcMap as attribute tables, then export the tables as text files for use in report documentation and to facilitate input to HEC-...
	6.3 Clark Unit Hydrograph parameters can be estimated using the Dam Safety Branch’s Clark UH parameters.xlsx spreadsheet, provided at the following DWR Google Drive link:  https://docs.google.com/spreadsheets/d/1acY4BqPT50dB_HgfI3rJ3b3ISwHTEjN4/edit?u...
	The CSU-SMA model method calculates Clark UH time of concentration, Tc, per Sabol (2008) for generally undeveloped basins in the Rocky Mountains, Great Plains, and Colorado Plateau, as:
	Sabol (2008) also provides Tc equations for agricultural and urban basins, which may be appropriate for developed basins and sub-basins.
	6.4 Linear Reservoir Baseflow method parameters are as follows: Reservoirs = 1, Initial Type = Discharge, GW1 Initial (cfs)=0, GW1 Fraction = blank, GW 1 Step is 1, and GW Coefficient = 3*R, where R is the Clark UH storage coefficient described above.
	6.5 For Muskinghum-Cunge Reach Routing parameters, use reach properties calculated per Section 5.2 above using HEC-HMS Parameters->Characteristics -> Reach.  Simple unit conversion may be needed.  The user must determine reach cross-section geometry. ...
	6.6 Table 6 below summarizes all CSU-SMA method HEC-HMS parameters, estimation methods, and recommended values, where applicable:
	6.7 Parameter Estimation Reporting Requirements:  Engineers should provide the following documentation (See example reporting in Appendix A):
	 Summary table of all parameter estimates listed in Table 6 above, by sub-basin (link to sample spreadsheet)
	6.8 Parameter estimates should be reviewed for reasonableness based on sub-basin properties (from Section 5) and comparison to USGS StreamStats basin properties, NRCS Web Soil Survey, published parameter values, and on basin characteristics and region...

	Section 7.  HEC-HMS Model Setup
	7.1 In HEC-HMS a new project with a basin model and terrain data should be created (described in Section 5.2 above for purposes of sub-basin delineation and determining sub-basin and reach properties).  See Figure 8 below.
	7.2 At this point all necessary model parameters have been generated and can be entered into the HEC-HMS model.  REPS temporal patterns for input to HMS were discussed in Sections 4 and 5 above.  SMA loss method, Clark UH, Linear Reservoir Baseflow, a...
	7.3 Precipitation Gage Time Series:
	7.3.1 For REPS design storms, the recommendation is to create a Precipitation Gage Time Series for each REPS storm (a zero-rain precipitation gage can be created to facilitate partial area analysis). Time series should be input in cumulative inches. T...
	7.3.2 Storm Durations: The recommendation for the CSU-SMA model method is to run all 2-hr through 24-hr design storms for minimum 2-day simulation duration and run all 48-hr & 72-hr duration design storms for minimum of 10-day simulation duration to e...
	Table 9: Recommended HEC-HMS simulation & precip time-series duration by REPS storm type
	7.3.3 REPS temporal distribution time series can be copied and pasted from REPS temporal distribution output text files into the HEC-HMS precipitation gage time series.  Tip: REPS MetPortal v2.2.0 allows the user to download precip frequency storm tem...
	A REPS temporal pattern spreadsheet tool to extend all PF and PMP distributions to the recommend time-series durations per Table 9 above can be downloaded from the following Google Drive link:  https://docs.google.com/spreadsheets/d/1HCPFrPRnbK3lt7TuO...
	Tip: For efficiency, in HEC-HMS a single precipitation gage can be created for each time increment/duration combination per Tables 8 and 9 above (e.g. 5-minute time interval, 2 day duration), then this “template” can be copied in HEC-HMS for each appl...
	Figures 9 and 10 below show example precipitation gage setup in HEC-HMS.

	7.4 Meteorological Model Setup:  A meteorological model should be created for each REPS design storm.
	Tip: For efficiency, the recommendation here, based on HEC-HMS 4.7, is to create the first meteorological model and setup annual evaporation.  This Met Model can then be copied for other storm types. Also, if partial area analysis is being done, then ...
	Figure 9: Precip Gage setup   Figure 10: Precip gage time series table
	7.4.1 Evaporation: Enter annual evaporation rate (0.098 in/hr, see Table 6 above) for all sub-basins.  Figure 11 shows an example evaporation element setup.
	7.4.2 Specified Hyetographs: Next create a Specified Hyetograph for each REPS design storm Met Model, which may be for up to 26 storms, depending on the basin location (2hr LS PMP, 6hr LS PMP, 24hr LS PMP, 72hr GS PMP, 72hr TS PMP, and 10e-1 through 1...
	NOTE: Alternatively, instead of creating a unique Precipitation Gage Time Series and Met Model for each of the 21 REPS Precipitation Frequency storms, a single Met Model could be created for each storm type using its REPS MetPortal unscaled temporal p...
	Lastly, using the recommended approach of creating a Met Model for each REPS storm, then the HEC-HMS simulation precip scaling can be used for the required 1.07 atmospheric moisture factor from State Dam Safety Rule 7.2 (see Section 10.2 below for mor...

	7.5 Basin Model Setup:
	7.5.1 Sub-basin elements.  Each sub-basin element in the HEC-HMS model should be set to the following methods: Canopy method = Simple Canopy, Loss Method = Soil Moisture Accounting, Transform method=Clark Unit Hydrograph, and Baseflow Method=Linear Re...

	7.6 HEC-HMS Control Specs: Table 9 above showed recommended simulation durations in order to ensure hydrograph recession limb and volumes are simulated completely, including subsurface flow from the SMA method.  In general, two control specifications ...
	7.7 Quality Control Check:  There is a large amount of HEC-HMS model input data between the CSU-SMA method and REPS design storms.  The model should be thoroughly QC checked by the user.  Sub-basin property summary tables (Section 5 above) and paramet...

	Section 8. HEC-HMS Output and Report Documentation
	8.1 In HEC-HMS a simulation run for each REPS design storm should be executed (in the Compute tab) using the correct basin model, meteorological model, control specifications, and precipitation ratio (if applicable).  Tip: HEC-HMS allows multiple simu...
	8.2 HEC-HMS output for hydrology reporting should be provided to Colorado Dam Safety, for review, as part of a comprehensive report, documenting the modeling effort, reasonableness checks (Section 9) and model calibration (Section 10).  HMS output rep...
	8.2.1 In HEC-HMS, print a summary report under Tools->Reports->Standard Reports. Due to the large number of REPS storms and large size of the Standard Reports, the recommendation is to print only the Standard Report for the inflow design flood (IDF) f...
	8.2.2 Using HEC-DSSVue or other graphing software, the following reservoir inflow hydrographs should be generated and included in the hydrology report:
	 All AEPs and PMP reservoir inflow hydrographs overlaid on a single graph for each REPS storm type
	8.2.3 Modeled peak flow frequency curves (reservoir inflows) should be plotted for all REPS precipitation frequency storms, along with flood frequency curves from USGS StreamStats estimates and applicable site-specific and/or regional stream gage floo...
	8.2.4 Reservoir inflow, reservoir stage, and reservoir outflow hydrographs from HEC-HMS should be plotted for 10e-4 AEP floods (all storm types) and for PMF floods (all storm types).
	8.2.5 For hydrologic risk analysis of existing dams (see Flowchart 1 at the beginning of these guidelines), reservoir stage probability curves (a.k.a., hydrologic hazard curves) should be plotted for all REPS precipitation frequency storms.  REPS PMF ...

	8.3 HEC-HMS results should be reviewed by the engineer for the following:
	 Calculate and tabulate the runoff coefficient for each design storm, which can be calculated as runoff volume divided by rainfall volume.  CSU (Irvin et al, under review) found runoff coefficients averaged around 30% in their mountain hydrology rese...
	 Compare baseflow and direct runoff hydrographs to determine which is dominant.  Also compare timing of baseflow and direct runoff peaks and the total hydrograph.  They should generally combine to form a steady rising limb, single peak, and then stea...
	 Review saturation fraction for larger volume design storm events.  Saturation fraction of 85% and above is assumed to cause saturation excess runoff (Woolridge, 2019).  Saturation-excess runoff may be indicated when the direct runoff hydrograph peak...

	Section 9.  Reasonableness Checks & Confidence
	9.1 Extreme flood estimates for dam safety evaluation and design in Colorado traditionally have been determined by extrapolation of uncalibrated rainfall-runoff models, often yielding, in the mountains and Western Slope, flood estimates several orders...
	In order to address this problem, we introduce the concept of reasonableness here, as referring to the situation where watershed model flood-frequency outputs of flood peaks and volumes for a range of AEPs are consistent with site-specific or regional...
	The intent of the reasonableness checks step here is to ground rainfall-runoff model estimates in the reality of the historical flood record.  As stated in Bulletin 17C, Guidelines for Determining Flood Flow Frequency (England et al, 2019):
	Over the past several decades, historical data and information have been shown to be extremely valuable in flood frequency analysis (Leese, 1973; Condie and Lee, 1982; Stedinger and Cohn, 1986, 1987; Cohn and others, 1997; England and others, 2003a). ...
	Further, Waltemeyer (2008), talking about regional envelopes of observed flood peaks, said they can “serve as a guide to the reasonableness of flood frequency estimates for large recurrence intervals.”
	As stated in Section 1 above: uncalibrated rainfall-runoff model results, per Sections 4 through 8 above, are viewed here only as a starting point, and reasonableness of such results should not be assumed.  Checking and calibrating model results again...
	Engineers should use multiple lines of evidence to make the case for reasonable design floods -– using gaged floods, indirect flood measurements, anecdotal flood records, and paleoflood studies.  Regional flood frequency methods, like USGS StreamStats...
	The following sub-sections provide guidance on specific reasonableness checks.   Also see Appendix A for Example Reasonableness Checks summary reports and Appendix C for a Reasonableness Checks template.
	9.2 Stream Gage Flood Frequency Analysis:  Many stream gages are or have been operated in Colorado, by the USGS, DWR, Mile High Flood District, and others.  If the basin of interest is gaged with a minimum of 10 years of non-zero annual peak flows, th...
	If the basin or site of interest is ungaged, then flood frequency analysis can be performed for stream gages at hydrologically similar locations in close proximity, if possible.  Then the resulting flood frequency estimates can be transpositioned to t...
	QT(u) = QT(g) (Au/Ag)x
	where, QT(u) is the unknown but desired flood frequency discharge (cfs) at an ungaged site for T-year average recurrence interval (ARI)
	QT(g) is the Bulletin 17C flood frequency discharge at a gaged site for T-year ARI
	Au is the drainage area in square miles at ungaged site
	Ag is the drainage area in square miles at stream gage
	x is the average exponent for drainage area, by region  Front Range Foothills~=0.6 and Eastern Plains~=0.33 (Kohn et al, 2016)*.
	* Kohn, et al (2016) provides specific area exponents by flood AEP. Note that fractional exponents are an indication of partial area contribution during flood events (Asquith and Kohn, 2022).
	Furthermore, Kohn and Asquith (2022) suggest that a more generalized ratio of regional peak flow predictor regression equations like those by Capesius and Stephens (2009) or Kohn et al (2016) is another reasonable method to transposition or rescale Bu...
	QT(u) = QT(g) (Au/Ag)x(Pu/Pd)y(Su/Sd)z
	where,  QT(u) is the unknown but desired flood frequency discharge at an ungaged site for T-year ARI
	QT(g) is the Bulletin 17C flood frequency estimate at a gaged site for T-year ARI.
	A, P and S are example predictor variables (area, mean annual precipitation, and main channel slope) at u, the ungaged site, and g, the gaged site.
	x, y and z are exponents on the predictor variables from a regional peak flow regression equation* of the form QT=Ax P y Sz
	*Specific regional peak flow regression equations for Colorado by flood AEP and by region, along with valid ranges of predictor variables can be found in Capesius and Stephens (2009) and Kohn et al (2016).  Use of the regression equations outside of t...
	Lastly, regional stream gages for multiple basin sizes can be used to define a regional flood frequency curve for a given AEP (e.g. 1/100) on a peak flow vs. drainage area graph, which then can be compared to REPS AEP model results for the basin-of-in...
	In terms of uncertainty for transpositioned or rescaled flood frequency estimates and for regional flood frequency curves, errors may generally be on the order of 1/4 to 1/3 log10 cycle, consistent with historical peak flow regression studies in Color...
	9.3 Regional Regression Flood Frequency Methods:  In conjunction with stream gage data, USGS StreamStats peak flow estimates should be determined for the basin-of-interest:  https://streamstats.usgs.gov/ss/
	USGS StreamStats provides regional regression equation flood frequency estimates, for 1/2 (i.e., 50%) through 1/500 (i.e., 0.2%) AEP.  Generally, USGS StreamStats flood frequency curves can be extrapolated to 1/1000 AEP for our purposes and then compa...
	Table 10 Relation of standard error (ASEp,%) to Log10 cycle (from Tasker, 1978)
	but as stated in the previous section, for purposes of these guidelines, modeled peak flows that are closer to flood frequency best estimates are considered more defensible.  Modeled peak flows should in all cases lie within 90% confidence bounds; sig...
	If a basin is gaged with a minimum of 10 years of non-zero peaks, then Bulletin 17C flood frequency estimates (Section 9.2) will generally have smaller uncertainty and should be given more importance than USGS StreamStats for checking against modeled ...
	9.4 Review of Historical and Paleo-Floods:  Much can be learned by investigating historical floods in the basin or region of interest.  Newspaper archives and local historical societies are good sources.  Colorado Dam Safety files often have records o...
	Paleo-flood studies, as a sub-set of historical floods, are particularly useful in providing upper limits of the largest floods that have occurred over hundreds to thousands of years (Jarrett and Tomlinson, 2000).  Paleo-flood studies use physical evi...
	Modeled reservoir stage probability curves (see Section 8.2.5 above) should be checked for consistency with the historical record at existing dams, in terms of controlling storm/flood types, record stage, frequency of spillway activation, past dam ove...
	9.5 Event Calibration:  For more advanced studies, flood reconstruction modeling of historical storms/floods can be performed.  For historical storms used in the REPS PMP study (see REPS Summary Report Vol. II, Table 2, for a list of storms) Colorado ...
	9.6 Controlling Storm Type: Modeled controlling REPS storm type(s) should be compared to the storm/flood type(s) of historical flooding for the basin or region of interest.  Information on storm types of observed, historical floods can be discerned fr...
	9.7 Seasonality of Controlling Storms/Floods:  In Colorado there are strong seasonal aspects to rainfall, storm types, and flooding, and these vary by region.  Historical flood and stream gage peak flow records provide information about the seasonalit...
	As a reasonableness check of rainfall-runoff model results, the seasonality of the controlling REPS storm type(s) (i.e. using model results and Figures 23, 24 & 25) should be checked against the seasonality of historical flooding for the basin/region ...
	Figure 23 (cont’d on next page):   Seasonal distribution of largest 50 Local Storms in each region. Top histogram is for north-west region, bottom is for north-east region (cf: Figure 22).  (REPS Vol. III, 2018)
	Figure 23 (cont’d from previous page):   Seasonal distribution of largest 50 Local Storms in each region.  Top histogram is for south-west region, bottom is for Rio Grande region (cf: Figure 22) (REPS Vol. III, 2018)
	Figure 24 (cont’d on next page):   Seasonal distribution of largest 50 Meso-scale with Embeded Convection (MEC) storms in each region. Top histogram is for north-west region, bottom is for north-east region (cf: Figure 22) (REPS Vol. III, 2018)
	Figure 24 (cont’d from previous page):   Seasonal distribution of largest 50 Meso-scale with Embedded Convection (MEC) storms in each region. Top histogram is for south-west region, bottom is for Rio Grande region (cf: Figure 22) (REPS Vol. III, 2018)
	Figure 25 (cont’d on next page):   Seasonal distribution of largest 50 Mid-Latitude Cyclone (MLC) storms in each region.  Top histogram is for north-west region, bottom is for north-east region (cf: Figure 22) (REPS Vol. III, 2018)
	Figure 25 (cont’d from previous page):   Seasonal distribution of largest 50 Mid-Latitude Cyclone storms in each region.  Top histogram is for south-west region, bottom is for Rio Grande region (cf: Figure 22) (REPS Vol. III, 2018)
	9.8 Regional Peak Flow Envelope Curves & USGS Colorado Flood Database:
	9.8.1 Modeled peak flows can be plotted on regional peak flow envelopes as a reasonableness check against maximum observed flood discharges.  Peak flow envelopes typically plot observed maximum floods -– gaged, indirect (i.e., surveyed after-the-fact)...
	Envelope curves have often been used to guide engineering design (Wolman and Costa, 1982).  Wolman and Costa (1982) state that envelope curves provide a useful check on peak flow estimates, but should not be relied on solely for engineering design bec...
	The U.S. Bureau of Reclamation uses regional peak flow envelope curves as part of hydrologic risk analysis.  Regional envelope curves capture important regional differences in flood production across Colorado.  The USBR’s regional peak flow envelope u...
	9.8.2 Colorado Dam Safety has used the USGS Colorado Flood Database (created in cooperation with Colorado Department of Transportation) to develop regional peak flow envelopes for Colorado, for the purpose of reasonableness checks of extreme flood rai...
	The USGS describes the importance of using historical and systematically collected flood data.  The purpose of the USGS Colorado Flood Database is to make low probability events in the systematic flood records available to water resources engineers to...
	https://co.water.usgs.gov/projects/COFloodDB/html/COFloodMap.html
	9.8.3 Colorado Dam Safety mapped the USGS Colorado Flood Database data set and experimented with regional groupings that showed similar peak flow limits in terms of maximum observed peak flows versus drainage area size.  Three peak flow envelope regio...
	Figure 27:  REPS PMP storm transposition zones (red) overlaid on terrain.
	Figure 28:  Colorado Dam Safety peak flow envelope regions:  (1) Eastern plains and Front Range foothills < 7,500 feet elevation (blue), (2) Mountains > 7,500 feet elevation (brown), and (3) Western Colorado < 7,500 feet (pink) with REPS PMP storm tra...
	both were large area events, but included smaller cells of embedded convection and high intensity rainfall.  It is worth noting that historical long-duration, low intensity PMP General Storms along the Front Range foothills (e.g. Sept. 2013 and 1969 B...
	USGS paleoflood estimates are included in the USGS Colorado Flood Database, but do not control the Eastern Plains/Front Range Foothills envelope. Several dam failure peak flows in the database were ignored for purposes of drawing our peak flow envelop...
	9.8.3.2  Mountains > 7,500 feet Elevation Peak Flow Envelope (Figure 30):  This envelope covers the orographically-sheltered region of the interior and high elevation Rocky Mountains of Colorado, including North Park and the San Luis Valley.  This env...
	Colorado Dam Safety’s Mountain Region envelope curve (red line in Figure 30) is controlled by the 1976 Big Thompson flood and the 1945 Quartz Creek near Ohio City flood at small area sizes (<10 sq mi). At 13.5 sq mi, the envelope is controlled by a US...
	Peak flows from the July 1999 Saguache Creek flood, provide by Dr. Jarrett via email, are shown on the Mountain Region envelope plot as grey X’s in order to demonstrate the possibility that larger flows at small area sizes may have in fact been debris...

	9.8.3.3  Western Colorado < 7,500 feet elevation Peak Flow Envelope (Figure 31):  Figure 31 applies to Colorado’s Western Slope below about 7,500 feet elevation, including the flanks of the San Juan Mountains, mesas and canyons of the Colorado Plateau...
	Red Canyon and No Thoroughfare Creeks near Grand Junction.  The related storms were not used for the REPS PMP study, but at such small area sizes it can be assumed they were intense, convective storms.  At larger area sizes (>100 sq mi), the envelope ...
	Crippen and Bue’s (1977) western region (Region 14) envelope is close to our Western Colorado envelope, except that the Crippen and Bue curve is higher at small drainage area sizes, where theirs is controlled by floods in Arizona, New Mexico, and Utah...
	9.8.4 Using the peak flow envelope curves for reasonableness checks:  Microsoft Excel files of Colorado Dam Safety’s Peak Flow Envelope plots can be downloaded from the following link to facilitate plotting and comparison of rainfall-runoff model disc...
	https://drive.google.com/drive/folders/1Q_Y6arM0Vd4NomgBB-U4NxTBOZ0zNz-c?usp=sharing
	The recommended use of Figures 29-31 is to plot all modeled REPS PMP and probabilistic peak flows for comparison, along with other reasonableness checks data, discussed above, for the basin of interest –- historical flood peak flows, flood frequency e...
	Our envelope curves are intended to provide a reasonableness check of extreme storm rainfall-runoff model results.  In the past, unchecked extrapolation of rainfall-runoff models to extreme events appears to have led to design storms that were orders ...

	Figure 32: Example peak flow envelope with modeled REPS PF and PMF peak flows, as well as data from reasonableness checks.
	make a case for defensible model results.  See Section 9.11 on confidence and Section 10 on using confidence to help weight observed flood data for use in model calibration.
	One of the most useful findings of the envelope plots is the regional differences in flood yields, particularly between the Eastern Plains/Front Range foothills (Figure 29) versus the rest of the state (Figures 30 and 31).  This regional difference ha...
	Finally, Figure 35 plots regional 1/100 AEP flood frequency estimates from USGS StreamStats and from Bulletin 17C, along with the USGS Colorado Flood Database observed peak flows, for our Mountains region >7,500 feet.  There is a moderate amount of sc...

	Figure 35: Regional 1/100 AEP (Q100) flood frequency estimates by USGS StreamStats (colored Xs) and by Bulletin 17C (colored circles) at selected sites in the USGS Colorado Flood Database, overlaid on observed peak flows (black dots) and the peak flow...
	9.9 Upper Tail Ratios:  The Upper Tail Ratio (UTR) is a statistic defined by Smith et al (2018) as the ratio of maximum observed flood to the 10-YR ARI flood frequency estimate for a basin.  The UTR may serve as a good reasonableness check because it ...
	Figure 35 above implies that UTR may decrease with larger area sizes.  In fact, cursory analysis by Colorado Dam Safety indicate as much (see Table 12, Figures 36 and 37).  Table 12 tabulates UTRs corresponding to envelope-controlling peak flows for o...
	Table 12:  Upper tail ratios for envelope-controlling peak flows in Colorado Dam Safety’s Mountain >7,500-ft elevation region
	9.10 Previous Hydrology Studies:  Lastly in terms of reasonableness checks on CSU-SMA rainfall-runoff model results, previous hydrology studies can be a good source of past hydroogical information, floods and analyses. Although their methods may be ou...
	9.11 Confidence:  The reasonableness checks described above are firstly intended to evaluate rainfall-runoff model accuracy.  However, they should also be used to build confidence.  For risk-informed decision making, Colorado Dam Safety ranks confiden...
	For Colorado Dam Safety hydrology study purposes, we propose that the following confidence levels should be used by the engineer/user to assess their results based on (1) REPS rainfall and CSU-SMA model confidence, (2) quality and amount of historical...
	Strong confidence:  Confidence in REPS PMP storm transpositions and REPS AEP estimates; hydrologically similar basins to those CSU-SMA research used for calibration and verification.  Stream gage data for basin-of-interest or transpositionable stream ...
	Table 13:  Example Confidence Levels from Colorado Dam Safety’s Guidelines for Comprehensive Dam Safety Evaluation (CDSE) Risk Assessments & Risk Informed Decision Making (RIDM), March 2021.
	Good agreement is found between CSU-SMA modeled floods and multiple lines of site-specific historical flood evidence, e.g., flood frequency estimates, flood seasonality, controlling storm types, historical floods, etc. vs. rainfall-runoff model result...
	Medium confidence:  Confidence in REPS PMP storm transpositions and REPS AEP estimates; hydrologically similar basins to those CSU-SMA research used for calibration and verification.  Good regional flood estimates are available (e.g. transpositioned/r...
	Poor confidence:  Less confidence in REPS PMP storm transpositions and wider confidence bounds on REPS AEP estimates; less confidence in CSU-SMA rainfall-runoff model parameters.  Only regional flood estimates (e.g. USGS StreamStats, peak flow envelop...

	Section 10. CSU-SMA Model Parameter Calibration
	10.1 Traditionally extreme floods for dam safety in Colorado were estimated by extrapolation of uncalibrated rainfall-runoff models to extreme storms, often with unreasonably conservative results –- several orders of magnitude larger than observed flo...
	10.2 Combining the CSU-SMA model approach and reasonableness checks against he observed flood record offers the opportunity for use of two independent sources of flood information to improve dam safety hydrology estimates.  Each method has advantages,...
	1) Determine the most likely controlling storm type for the basin based on comparison of initial CSU-SMA model results versus basin area size (see Section 9.6 and Table 10), type of historical storms/floods (Sections 9.4 and 9.8), and seasonality of h...
	2) Calibrate CSU-SMA model parameters to obtain reasonable agreement between the REPS 10e-2 AEP controlling storm-type peak flow and the 1/100 AEP flood frequency estimate from the observed flood record (e.g. by Bulletin 17C, transpositioned Bulletin ...
	3) Similar checks between modeled peak flows and flood frequency estimates and further calibration, if needed, should be made at 2x10e-3 and 10e-3 AEPs.  Consideration should be given to calibrating to paleo-flood peak flow estimates, if available for...
	5) Lastly, run REPS PMP (all applicable storm types) in the calibrated CSU-SMA model, and the controlling modeled PMF peak flow should be checked against Colorado Dam Safety’s regional peak flow envelopes.  For the purposes of these guidelines, closer...
	Table 15: Weights for modeled REPS PMF peak flow and regional envelope peak flow, based on confidence level, for final CSU-SMA model calibration to weighted average PMF.
	The following additional considerations are offered for model calibration:
	 Where a basin spans multiple peak flow envelope regions, then an area-weighted average envelope peak flow may be used or use partial area analysis in the controlling region.
	 Particularly for the Front Range & Eastern Plains region, large differences in the observed flood record between regional envelope peak flows and more frequent 1/100 and 1/1000 AEP floods suggest possible non-linear runoff response to extreme rainfa...
	 Calibration to regional peak flow envelopes may not capture basin-specific differences.  Our experience is that the regional differences that are captured by the regional envelope curves far out-weigh basin-specific differences (when compared to his...
	 Notional AEP of PMP and PMF can be determined by comparing REPS PMP results against REPS precipitation frequency (see Sections 4 and 8 above).  This cross-check is a strength of REPS.  Where notional AEP of REPS PMP/PMF is far less than 10e-7 AEP, t...
	 Climate change has the potential to increase flood yields in Colorado in the future (REPS Summary Report, Vol. VI).  Based on the recommendations by NOAA and others, Colorado Dam Safety implemented Dam Safety Rule 7.2.4, Atmospheric Moisture Factor ...
	 Where observed peak flows and historical flooding are dominated by snowmelt, which is true for many basins above 7,500 feet elevation in Colorado, then rainfall flood frequency estimates are necessarily lower, at least within the period of record.  ...
	 As discussed in Section 9, advanced studies may perform historical flood event calibration using reconstructed rainfall and stream gage flood hydrographs, reservoir stage records, etc.  If possible, independent verification should be done on multipl...
	10.3 This section provides information on specific CSU-SMA model parameters for calibration. Select parameters can be adjusted based on controlling storm type and controlling runoff mechanisms in order to better match historical flooding:
	10.4 The following additional guidance is provided on parameter calibrations for emphasizing different runoff production mechanisms:
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